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Changes and Improvements
Version 3.00

•	 Added support for 8000 Hearing Aid Test System

•	 Added Coupler Directional for the FONIX 8000 Hearing Aid Test System

•	 Fixed copy selection for DSL in NAL/DSL test.

•	 Fixed right ear identification in ANSI test screens

•	 Fixed battery pill size in ANSI test screens.

Version 2.90

•	 Added ANSI 03 test

•	 Updated JIS to JIS 2000

•	 Major updates to ANSI 87 and ANSI 96 tests

•	 Fixed WinCHAP NOAH Module XML import

•	 Fixed WinCHAP NOAH Module installation process

•	 Added automatic search for COM and baud rate settings

•	 In the WinCHAP NOAH Module, NOAH audiograms were listed from oldest 
to newest and WinCHAP audiograms were listed from newest to oldest. Now 
both lists are from oldest to newest to be consistent with other NOAH list for-
mats.

•	 In the Real-ear Test, some curves obtained from the 6500-CX Real-ear SPL 
screen were mislabeled. This has been fixed.

•	 In the Real-ear Test, the 7000 target curves obtained with Get Curves were 
shifted by frequency. This has been fixed.

•	 In the ANSI test windows, if multiple lines of comments were used, the I/O 
data would print out over many pages. This has been fixed.

•	 In the DSL/NAL Test, the Test Instrument selection was not being included on 
printout nor were the test comments. This has been fixed.

•	 In the DSL/NAL Test, comments have been added to the printout.

•	 In the Audiometric Test, masking was being incorrectly recorded. This has 
been fixed.

•	 In the Main Menu, the Time setting was removed since it didn’t have any 
function.

•	 The Time/Date sub-menu was also removed, and the Date setting moved onto 
the main Settings menu.

•	 In the JIS test, attack and release and I/O measurements were added.
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Version 2.80

•	 Added electronic help files

•	 Fixed some bugs in the NAL-NL1 target

•	 Added ability to re-label curves in the Response Curves and Real-Ear tests.

•	 Changed the no-response behavior in the Audiometric Test window to use 
last stimulus amplitude instead of maximum amplitude. This duplicates 
NOAH behavior.

•	 Fixed importation of no-response values into NOAH with NOAH WinCHAP 
module.

•	 Added importation of speech data into NOAH with NOAH WinCHAP module.

•	 Fixed a bug in the Response Curves and Real-Ear tests in which, if you had 
more than 9 curves in the window, Curve #10 would be re-labeled as Curve 
#1 upon saving and re-entering the test.

•	 Added ability to change the COM port configuration to every  test window.

•	 Added Spectrum Analysis mode in the DSL/NAL-NL1 test

•	 Updated the Audiometric Test window display to make it more readable 

Version 2.71

•	 Added support for the 7000 Hearing Aid Test System. 

•	 Added ability to copy data onto clipboard

Version 2.70

•	 Improved the fitting module (DSL/NAL-NL1)

°	 Added NAL-NL1 screen

°	 Added Composite & Digital Speech measurements

°	 Improved the user interface for taking measurements

•	 Improved the Audiometric Test screen

°	 Added cursor lines on the graph to make identifying frequencies easier

°	 Improved the layout of the Speech Audiometry screen

°	 Added an Impedance screen

•	 Fixed some NOAH 3 data import bugs

•	 Added new date formats

•	 Added new print header options

•	 Added analyzer functions to Main Menu.

•	 Added ability to specify the curves, including reference curves, that are 
grabbed with the “Get Curves” command in the Response Curves and Real-
Ear screens.



WinCHAP User’s Manual	 Changes and Improvements  3

WinCHAP version 2.60

•	 Added NOAH XML data import to allow import of entire NOAH 3 database, 
including hearing aid information.

•	 Added Quick Entry Hearing Aid and Quick Entry Client screens.

•	 Improved Hearing Aid Entry screen in the Office Manager.

°	 Removed show/hide individual aids button.

°	 Changed individual aid listing to a cleaner format.

°	 Added attached client to aid listing.

°	 Moved individual aid edit to its own window.

°	 Cleaned up the user interface.

°	 Aid type & battery info moved to individual aid info from hearing aid 
model info.

°	 Aid warranty & purchase dates added to individual aid info.

•	 Enhanced the List, Sort, & Search buttons in Office Manager.

°	 Sort order can be saved.

°	 Column widths and heights are changeable.

•	 Added “Client Services” screen that works like a checkbook register to add 
basic payment and charge information to the client’s account.

•	 Hot keys added to some menu functions.

•	 Test Menu listings modified to display more information about the aid.

•	 Added more checks in data so that when a user creates a test or updates data 
in the Office Manager, WinCHAP prompts whether or not to save data when 
user leaves the screen without saving.

•	 Icons in many screens have been enlarged and are more consistent with each 
other for easier use.

•	 Added some RS232 functions to test screens that cause the FONIX analyzer 
to print and reset. Also added ability to change print label on analyzer.

•	 DSL Screen updated.

°	 Performance vastly improved.

°	 Mid & High level verification screens combined.

°	 Moved verification data to its own lookup screen, allowing for a larger 
graph.

°	 Removed client data screen and moved some functions to Info screen.

°	 Changed Specification screen to Info screen, removed its graph.

°	 Added ability to save client & general default settings.

°	 Removed separate verification windows. Now measurements are done 
directly on the verification graph.
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Introduction
WinCHAP is a Windows-based FONIX Computer Hearing Aid Program that is 
used for interfacing your FONIX instruments with your personal computer. 
Store all your measurements while maintaining a complete office management 
database. In the WinCHAP Office Manager, you can store extensive client, hear-
ing aid, manufacturer, test instrument, and personnel information. This infor-
mation can be entered manually or imported from NOAH 3. In the WinCHAP 
Test Menu, you can perform hearing aid and audiometric measurements and 
store them electronically, eliminating the need for paper files.

WinCHAP has gone through some fairly significant changes since its incep-
tion, including 32-bit programming, improved user interface, and greater testing 
capabilities. Many of these changes came from direct feedback from our valued 
customers. In order to further improve WinCHAP’s usability, we invite you to 
contact us with any comments or suggestions for improvement at: support@
frye.com.

1.1  Installation
This section describes how to install WinCHAP and upgrade it from an older 
version.

1.1.1 Installing WinCHAP
Installing WinCHAP is a fairly straightforward process. 

1.	Un-install any previous versions of WinCHAP.

2.	Backup any WinCHAP database files you may be using.

3.	Close all programs running on your Windows system.

4.	Insert the WinCHAP CD-ROM into your CD-ROM drive.

5.	Wait for the installation program to run. If this doesn’t happen automati-
cally, run “setup.exe” on the WinCHAP disk.

6.	Let the installation program guide you through the process.

7.	After installation, you will need to connect your FONIX equipment to 
your computer and configure the connection.

Note 1: In some cases, an error message may open, indicating that one of the 
.dll files is in use. Click Ignore and continue the installation. In most cases, the 
installation will still be successful.

Note 2: If you are upgrading from WinCHAP version 2.0 or earlier, you must 
import your old WinCHAP database before it can be functional with the new 
version. This is not necessary if you are upgrading from WinCHAP 2.1 or above.
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1.1.2  Installing WinCHAP on Windows 7

WinCHAP should install normally on a Microsoft 7 Operating System (32-bit or 
64-bit). However, if you double-click on the WinCHAP icon to open the program, 
you may get this message:

	 To fix this issue and run WinCHAP, right-click on the 
WinCHAP icon and select Properties.

This will open the WinCHAP Properties 
window. Select the Compatibility tab. 
Select Run the Program in Compatibility 
Mode and choose Windows XP (Service 
Pack 3). Click Apply. This should allow 
WinCHAP to run normally on your 
Windows 7 system. The setting is saved 
automatically.

1.1.3  Uninstalling WinCHAP
You will need to uninstall WinCHAP from your computer before you can install a 
new version.

1.	Press the Start button of your Windows operating system.

2.	Select Settings and Control Panel.
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3.	Select Add/Remove Programs.

4.	Find and highlight WinCHAP or WinCHAP 32 in the list of programs.

5.	Click the Add/Remove button. The install shield will guide you through 
the un-install process. It should take just a few minutes.

1.1.4  Backing up your database
It’s a good idea to periodically backup your database. WinCHAP data is stored in 
a Microsoft Access database file, so to back up your data, you just need to make 
a copy of this file.

1.	Open WinCHAP.

2.	Open the Settings menu and click Database Manager to open it.

3.	Open the Tools menu and select Backup Database File. This creates a 
backup of the database file in the backups sub-directory located in the 
directory where you installed WinCHAP (usually C:\program files\frye 
electronics\winchap)

1.1.5  Registering WinCHAP
If you purchased your copy of WinCHAP, or if you are receiving a free upgrade 
from a previous version of WinCHAP, both the serial number and the registra-
tion key should be included on the WinCHAP CD-ROM case.

If you ordered a demo copy of WinCHAP in order to evaluate it, you can pur-
chase a copy and thus receive the serial number and registration key by contact-
ing us at:

Frye Electronics, Inc.        
PO Box 23391
Tigard, OR 97281-3391
(503) 620-2722
(800) 547-8209
Fax: (503) 639-0128
sales@frye.com

If you have not yet registered your copy of WinCHAP, a window will pop up 
every time you open WinCHAP and ask if you would like to register it. Click Yes 
to input the serial number and registration key. Once this has been done, the 
prompts will no longer appear. 

1.2  Requirements
Your computer must meet the following requirements:

•	 Windows operating system: 98, 2000, Me, NT 4.0, XP, and Windows 7 (32-bit 
and 64-bit)

•	 Pentium computer or equivalent 
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•	 32 MB of RAM (64 MB recommended)

•	 30 MB of free hard disk space for the program to function optimally. Large 
databases could require an additional 100 MB or more of disk space.

•	 Video resolution: 1024 x 768

WinCHAP has been tested on the following software. If your hearing aid ana-
lyzer has a previous software version, some features may not have complete 
functionality:

•	 7000: 1.63

•	 FP35: 5.01

•	 8000: 2.01

•	 6500-CX: 4.91

•	 FP40/FP40-D: 3.70

•	 FA10/FA12: all versions

The 6500-CX and FP40 hearing aid analyzers, and FA10/FA12 audiometers must 
be equipped with the RS232 Option. RS232 is included on all 8000, 7000, and 
FP35 hearing aid analyzers.

1.3  Setup
In order for WinCHAP to gather measurement data from your FONIX equip-
ment, your FONIX analyzer/audiometer must be equipped with the RS232 pro-
tocol, and it must be connected to your computer using an RS232 cable. The 
FP35, 8000, and 7000 hearing aid analyzers include the RS232 capability as a 
standard feature. The RS232 capability is an option on the 6500-CX, FP40, and 
FP40-D hearing aid analyzers and all FONIX audiometers. 

A USB serial cable comes with all FONIX equipment with the RS232 capability. 
The driver for this cable must be installed. Typically, the hardware wizard needs 
to run twice for complete installation of this cable.

If you are having intermittent connection problems and you have a desktop 
computer, we recommend installing an electronics card with additional RS232 
ports and using a standard RS232/serial cable for your connection.

Once you have connected your computer to your analyzer, make sure to set the 
communications port on WinCHAP. See Section 2.2 for more information.
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Configuration
This chapter describes how to configure your analyzer’s connection to your 
FONIX analyzer or audiometer, set up your database, and change your printing 
header. 

2.1  The Main Menu
When you first open WinCHAP, you will come to the Main Menu. See Figure 
2.1. The Main Menu is the navigational focus of WinCHAP. It is from this win-
dow that you will enter the Data Entry Menu, the Test Menu, and the various 
configuration windows.

In addition to being a portal into other parts of the program, the Main Menu 
also contains several miscellaneous functions. 

Figure 2.1—Main Menu

2.1.1  Getting NOAH 3 information
You can go to the NOAH Tools window from the Main Menu. See Chapter 8 for 
more information.

2.1.2  Going to the Frye website
You can go directly to the Frye website by clicking Frye Website from the About 
menu in the Main Menu.
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We are constantly updating our website to contain our latest product features as 
well as any supplementary instructional information available. WinCHAP pre-
fers to use Internet Explorer for opening the Frye Website.

Shortcut: Type Ctrl+W from the Main Menu to go directly to the Frye website.

2.1.3  Checking your FONIX analyzer connection
You can check your FONIX analyzer connection from the Main Menu:

1.	 Open the Settings menu.

2.	 Point to Communications.

3.	 Click Check Analyzer. This will display the status of your analyzer’s con-
nection to your computer at the bottom of the Main Menu.

Shortcut: Type Ctrl+M from the Main Menu to check your analyzer’s connection.

2.1.4  Getting basic WinCHAP information
You can get basic Frye contact information, WinCHAP’s software version, and 
your product’s serial number in the About WinCHAP window.

Open the About menu in the Main Menu and click About WinCHAP. This will 
open the About WinCHAP window.

2.1.5 Setting your analyzer’s internal printing label
WinCHAP can change the label used when performing a print screen from your 
analyzer.

1.	 Open the Settings menu.

2.	 Point to Communication.

3.	 Point to Analyzer Tools.

4.	 Click Set Label. This will open the Analyzer Label Settings window.

5.	 Fill in the lines as you would like them to appear on your analyzer print-
outs.

6.	 Click Set. This will save the displayed label, even when you reboot your 
analyzer.

7.	 Click Back to close the Analyzer Label Settings window.

To return the label to the factory setup, follow the same instructions, but click 
Restore. 



WinCHAP User’s Manual	 Configuration  11   	

2.1.6 Controlling your analyzer remotely
In addition to setting the label and checking the analyzer’s connection, you 
can also perform a few other remote operations from WinCHAP’s Main Menu. 
The following controls are reached when you open the Settings menu, point to 
Communication, and point to Analyzer Tools:

•	 Reset: Remotely presses your analyzer’s reset button.

•	 Level: Remotely levels the sound chamber of your analyzer. See your ana-
lyzer’s operator’s manual for correct setup.

•	 Print: Remotely prints to your analyzer’s internal or connected external 
printer, depending on how your analyzer is set up.

•	 Line Feed: Remote feeds your analyzer’s internal thermal paper printer.

2.2  Serial Port Configuration
WinCHAP communicates with your FONIX analyzer or audiometer using one 
(or more) of your computer’s serial communication ports (also known as “COM 
ports”). See Section 1.3 for information on the physical connection between 
your FONIX equipment and your computer.

To configure your COM ports:

1.	 Open the Settings menu from the Main Menu.

2.	 Point to Communication and select FONIX Communication Setup. This 
will open the FONIX Communications Setup window. 

3.	 Enable the Enable Auto COM Port and Baud Rate search selection.

4.	 Click the Check Analyzer or Check Audiometer button to verify your con-
nection. The Auto Search feature enabled in the last step should automat-
ically determine the COM port and baud rate used by the connected Frye 
analyzer and/or audiometer.

5.	 Close the window.

Most FONIX equipment, such as the FONIX 6500-CX analyzer, FP40 analyzer, 
and FA10/12 audiometer, has a fixed baud rate of 9600. You should not attempt 
to adjust the communications baud rate for these instruments.

The FP35 and 7000 analyzers, however, have an adjustable baud rate. To 
adjust it, select the new baud rate with the Baud Rate drop-down list in the 
Communications Setup window. You will also have to make the same adjust-
ment to the baud rate on your FP35 or 7000 analyzer. See your analyzer’s opera-
tor’s manual for more information.

If you have a 7000 or 8000 Hearing Aid Test System, there are a few additional 
advanced settings available for your communiation setup. Click the Advanced 
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Settings button to access these settings.

•	 Poll Delay: This is the amount of time the analyzer waits for the computer 
communication poll. If you are using a USB to serial adapter (or USB 
serial cable), lengthening this delay may improve the stability of the com-
munication with your computer. The analyzer does not save this setting 
permanently so it must be reset after turning off and on the analyzer. Do 
not set this delay below 40.

•	 Poll Holdoff

Shortcut: Type Ctrl-L from the Main Menu to go directly to the Communication 
Setup window.

Figure 2.2.—Communications Setup Window



WinCHAP User’s Manual	 Configuration  13   	

2.3  Database Manager 
You will need to use the “Database Manager” if: 

•	 You are upgrading from a version of WinCHAP prior to version 2.1. We 
made some changes to the database in version 2.1 that require the old 
database to be imported before you can use the latest version.

•	 You have a reason to separate your records into categories—for instance, 
according to different office branches—you can create new databases in 
addition to the default database. 

•	 You have been using the original FONIX CHAP software, and you want to 
import the information you have stored there to a WinCHAP database. 

•	 You wish to combine existing WinCHAP databases.

Shortcut: Type Ctrl-B from the Main Menu to go directly to the Database 
Manager.

Figure 2.3—Database Manager
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2.3.1  Changing databases
1.	 Open the Settings menu in the Main Menu and select Database Manager.

2.	 In the Select Directory column in the Database Manager, select the direc-
tory containing the WinCHAP database you wish to open.

3.	 In the Database Files column, highlight the database you wish to open.

4.	 Click Open WinCHAP Database.

5.	 Click Run. This database will now be your default database.

2.3.2 Using WinCHAP with a network
It’s easy to set up WinCHAP to work within a network.

1.	 Copy your WinCHAP database file onto the network computer accessible 
by the other computers on the network. If needed, get your local comput-
er support person to help you with this.

2.	 Install WinCHAP on each computer that will be using it.

3.	 On each computer, follow the instructions found in Section 2.3.1 to open 
the database stored on the network in Step 1. 

2.3.3  Creating a new database
If you need more than one database to separate files into different categories, 
you can easily create a second, a third, or as many databases as you need.

1.	 Click Create WinCHAP Database in the Database Manager.

2.	 Click Run. A message will open asking you to name the new database. 
Choose a name that is eight characters or less (not including the exten-
sion).

3.	 Click OK to create the database.

2.3.4  Deleting a database
While you can delete individual items from a database directly from WinCHAP; 
you have to use Windows Explorer to delete a complete database.

1.	 Enter Windows Explorer.

2.	 Find the WinCHAP folder and open it.

3.	 Locate the database you want to delete, and highlight it.

4.	 Click the delete button on your keyboard. A message will open confirm-
ing the decision to delete.

5.	 The deleted database will remain in your computer’s Recycle Bin until 
the Recycle Bin is emptied.
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2.3.5  Importing a CHAP database
CHAP is the DOS-based predecessor to WinCHAP. All CHAP data can be imported 
to WinCHAP, although not all of it will correspond exactly to the WinCHAP data 
entry text boxes. See Table 2.3.5.

1.	 Click Import CHAP Database in the Database Manager.

2.	 Use the Select Directory column to find the directory where your CHAP 
database is stored.

3.	 Click Run. This will open the “CHAP Database Import Menu” window that 
will detail your CHAP database transfer as it happens. See Figure 2.3.5.

4.	 Decide how you would like to deal with redundant client records by using 
the radio buttons on the window. 

5.	 Click Start to begin the import process. As the data is being imported, 
you will see the import process being detailed on the window. The CHAP 
import process can take a long time because every action is reported to a 
log file, and all the data is examined before it is imported to make sure it is 
not corrupt or redundant.

TABLE 2.3.5 
Differing Fields Between CHAP and WinCHAP

CHAP WinCHAP
Addr1, Addr2, Addr3, Addr4 Address (will assign to City, State 

and Zip Code fields, if possible)
Name First Name, Last Name
Note1, Note2, Note3, Note4 Comment

		

Figure 2.3.5—CHAP Database Import window
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2.3.6  Importing a WinCHAP database
1.	 Click Import WinCHAP Database in the Database Manager

2.	 Use the Select Directory column to find the directory where your 
WinCHAP database is stored. Use the Database Files column to select 
the database you want to import.

3.	 Click Run. This will open the WinCHAP Database Import window that 
will detail your WinCHAP database transfer as it happens. See Figure 
2.3.6.

4.	 Choose what to do if the database encounters redundant client informa-
tion, using the radio buttons at the bottom of the window.

5.	 Choose what type of data you would like to import, using the buttons 
on the right side of the window. You can import everything or limit the 
import to specific fields. To choose more than one field, hold down your 
control key as you choose your selections.

6.	 Press Start to start the import process. As the data is being imported, 
you will see the progress being detailed on the window. The WinCHAP 
import process can take a long time because every action is reported to a 
log file, and all the data is examined before it is imported to make sure it 
is not corrupt or redundant.

7.	 Click Back to exit from the Import WinCHAP Database window when 
finished.

Figure 2.3.6—WinCHAP Database Import window
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2.4  The Print Menu
If desired, you can add your company logo and a three line header to every page 
printed by WinCHAP. To open the Set Printer Header window, select Printing 
from the Settings menu in the Main Menu. This will open the window shown 
in Figure 2.4.

Figure 2.4—Set Report Header and Logo window

You can choose to use one of three sizes of logos at the top of the printouts: 
Short (4 cm x 2 cm), Medium (13 cm x 2 cm), and Long (16 cm x 2 cm). Click 
the Browse box located to the right of the each selection in order to choose 
a picture file of the appropriate size to use for your logo. Make sure to select 
Enable Logo  to make the logo appear on your printouts.

Click the Report Header tab and input up to three lines to use as the header on 
your printouts. To use the header, select Enable Header.

The General tab lets you set the paper size to be used in your printouts. Select 
8.5” x 11” for the standard U.S. paper size or A4 for the standard European 
paper size.

Click Save to store all print settings.
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2.5 Date/Time Settings
There are several different ways to display the date format in WinCHAP. To 
change the selected format:

1.	 Open the Settings menu in the Main Menu.

2.	 Point at the Date selection.

3.	 Choose the desired setting where D = day, M = month, and Y = year. 
The following are available:

•	 mmm/dd/yyyy (Jan/02/1970)

•	 dd/mmm/yyyy (02/Jan/1970)

•	 yyyy/mmm/dd (1970/Jan/02)

•	 mm/dd/yyyy (01/02/1970)

•	 dd/mm/yyyy (02/01/1970)

•	 yyyy/mm/dd (1970/01/02)

Your selected date format will automatically be saved. You cannot change the 
time format at this time.
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Office Management
Before you can start testing clients and hearing aids, you must enter basic infor-
mation about them into the WinCHAP database. You can enter data using the 
Quick Entry windows and the Office Manager.

•	 The Quick Entry windows let you enter limited client and hearing aid 
information quickly and easily. It’s a good tool to use if you’re in a rush, 
and you don’t need to enter detailed information about a hearing aid or 
client.

•	 The Office Manager is a more complete data entry window that lets you 
enter extensive client, hearing aid, manufacturer, test instrument, and 
personnel information. 

3.1  The Data Entry Window
In the Data Entry window, you choose between using the Quick Entry windows 
and the more complete Office Manager.

Figure 3.1—Data Entry window

To enter the Data Entry window, click the Data Entry button in the Main Menu. 
See Figure 3.1 for a view of the Data Entry window. All hearing aids and cli-
ents entered in the Quick Entry windows will be accessible through the Office 
Manager after you’ve entered them.

Shortcut: Type Ctrl+D to go directly to the Data Entry Menu from the Main Menu.
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3.2  The Quick Entry Windows
There are two Quick Entry windows: one for entering client information, and 
one for entering hearing aid information. 

•	 If you want to enter a client and an attached hearing aid, use the Quick 
Entry Client window. 

•	 If you want to enter a hearing aid, use the Quick Entry Hearing Aid win-
dow. You can attach the aid to an existing client, if desired.

3.2.1 Using the Quick Entry Client Window
In the Quick Entry Client window, you can quickly enter basic client informa-
tion such as first name, last name, client number, birthday, and a few other 
fields. See Figure 3.2.1.

Figure 3.2.1—Quick Entry Client window

3.2.1.1  To enter a client
1.	 Enter the Data Entry window by clicking Data Entry in the Main Menu. 

2.	 Click the Client button in the Data Entry window to open the Quick Entry 
Client window (Figure 3.2.1). Alternatively, you can open the Tools menu 
and select Quick Entry Client.

3.	 Enter relevant client information using the provided fields. You must at 
least enter the client’s first and last name.

4.	 Click Save when satisfied.
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3.2.1.2  To attach a new hearing aid record
Creating a hearing aid record from the Quick Entry Client window will link the 
records together within WinCHAP.

1.	 Enter the client information into the Quick Entry Client window as 
described in Section 3.2.1.1.

2.	 Click Add Aid. This will open the Quick Entry Hearing Aid window. See 
Section 3.2.2 for instructions on entering a hearing aid.

3.	 Click Back in the Hearing Aid window to reenter the Client window and 
confirm that your hearing aids have been attached to the client.

Any hearing aids entered in this manner will be automatically attached to the 
client. See Section 3.2.3 for an example.

3.2.1.3  Other stuff in the Quick Entry Client window
•	 Click New to enter a new client and begin the process again.

•	 Click Test to go to the Test Menu and start testing the client.

•	 Click Back to close the window.

3.2.2  The Quick Entry Hearing Aid Window
In the Quick Entry Hearing Aid window, you can quickly enter the hearing aid 
model, serial number, ear, and a few other fields. If you enter this window from 
the Quick Entry Client window, any aids entered will be attached to that client. 
See Figure 3.2.2.

Figure 3.2.2—Quick Entry Hearing Aid window
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3.2.2.1  To enter a hearing aid
1.	 Enter the Data Entry window by clicking Data Entry in the Main Menu. 

2.	 Click the Hearing Aid button in the Data Entry window to open the Quick 
Entry Hearing Aid window (Figure 3.2.2). Alternatively, you can select 
Quick Entry Hearing Aid in the Tools menu. 

3.	 Enter relevant hearing information using the provided fields. You must 
enter the hearing aid’s model and serial number. 

4.	 Click Save when satisfied.

Note: You can also enter the Quick Entry Hearing Aid window from the 
Quick Entry Client window. This will attach the hearing aids to the client 
shown in the Client window.

3.2.2.2  To attach a client from the Quick Entry Hearing Aid window
Use the Attach Client button to attach an existing client record to a newly 
entered hearing aid record.

1.	 Follow the directions in Section 3.2.2.1 to create a hearing aid.

2.	 Click Attach Client to bring up the Client Search window.

3.	 Type the appropriate search criteria into the provided fields to locate the 
client in the database.

4.	 Select the client’s name to select the client and attach it to the hearing 
aid. This will close the Client Search window and return to the Quick 
Entry Hearing Aid window. The attached client’s name will be displayed 
at the bottom of the window.

5.	 Click Save.

3.2.2.3  Other stuff in the Quick Entry Hearing Aid window
•	 Click New to enter a new hearing aid.

•	 Click Test to go to the Test Menu and start testng the hearing aid.

•	 Click Back to exit the window.

3.2.3  Example
Here’s an example of a client with a binaural pair of hearing aids:

Jeff Jones
Left Aid: Acme model, serial number 12345678
Right Aid: Acme model, serial number 12345679
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To enter this client and hearing aid:

1.	 Click Data Entry in the Main Menu.

2.	 Click Client in the Data Entry window. This will open the Quick Entry 
Client window.

3.	 Enter Jeff into the First Name category, and enter Jones into the Last 
Name category.

4.	 Click Save.

5.	 Click Add Aid. This will open the Quick Entry Hearing Aid window.

6.	 Enter Acme into the Model category, enter L in the Ear category, and enter 
12345678 into the Serial Number category.

7.	 Click Save.

8.	 Click New.

9.	 Enter Acme into the Model category, enter R in the Ear category, and enter 
12345679 into the Serial Number category.

10.	Click Save and Back. This will return you to the Quick Entry Client 
Window. You should see both aids in the Client’s Hearing Aid box.

11.	Click Test to enter the Test Menu and start testing.

3.3  The Office Manager
In the Office Manager you can enter and modify client and hearing aid data, 
track your hearing aid inventory, store information about manufacturers and test 
equipment, and organize your personnel records.

There are five sub-windows in the Office Manager: Client-Patient, Hearing Aid, 
Manufacturer, Test Instrument, and Personnel. Enter each sub-window by click-
ing on its icon located in the left column of the window.

Each window has multiple text boxes where you can enter and update informa-
tion. Select one by clicking on it, or use the tab key on your keyboard to move 
among text boxes. Some of these text boxes have a small black check next to 
them. These fields must be filled in order to save the record.

To enter the Office Manager:

1.	 Click Data Entry in the Main Menu.

2.	 Click Office Manager in the Data Entry window. This will take you to the 
Office Manager. 
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3.3.1  Using the Client-Patient Window
In the Client-Patient window you can store detailed client information including 
contact information, insurance information, and the type of hearing loss.

Figure 3.3.1—The Client-Patient window

3.3.1.1  To enter a client record
1.	 Enter the Client-Patient window by clicking the Client-Patient icon in the 

left column of the Office Manager. window See Figure 3.3.1 for a view of 
the Client-Patient window.

2.	 Click New in the top left corner of the window. This will open a new 
record. 

	 Note: If you are starting with a blank database, you will automatically be 
in a new record.

3.	 Enter the first name and last name of the client (required fields) and any 
other desired information. 

4.	 To add a picture to the client’s record, see Section 3.3.6.6.

5.	 Click Save to save the record.
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You can click the Cancel button in the top left corner of the window to can-
cel the new record without saving.

3.3.1.2  To delete a client record
1.	 Use the Search icon (represented by a pair of binoculors) to locate the cli-

ent you want to delete. See Section 3.3.6.1 for details.

2.	 Click the Delete icon (represented by a recycle bin) on the Office Manager 
toolbar. This will delete the selected client.

3.3.1.3  To attach a hearing aid
1.	 Enter the hearing aid data by following the instructions found in Section 

3.3.2.

2.	 Enter the Client window by clicking Client-Patient in the left column of 
the Office Manager.

3.	 Find the client to whom you want to attach the hearing aid. Use the 
Search button if necessary. See Section 3.3.6.1.

4.	 Locate the Available Hearing Aids box on the right side of the Client win-
dow. This is the list of aids unattached to any client records.

5.	 Highlight the hearing aid you would like to attach and click Add Aid, 

	 -or-

	 Click Search Aid to open a hearing aid search window and search for the 
hearing aid among the list of available hearing aids. When you find the 
aid you want, double-click it, and it will automatically attach itself to the 
client and close the search window.

6.	 Locate the Client’s Hearing Aids box above the Available Hearing Aids 
box. You should see the newly attached hearing aid in that box.

7.	 Click Save to save the attachment.

	 Note: You can also attach the hearing aid in the hearing aid data entry 
window.

3.3.1.4  To un-attach a hearing aid
1.	 Open the client record to want to alter. Use the Search icon if necessary. 

(See Section 3.3.6.1.)

2.	 Locate the Client’s Hearing Aids box above the Available Hearing Aids 
box on the right side of the Client window.

3.	 Select the hearing aid that you want to remove. A box will pop up to con-
firm your decision.

4.	 Click Yes to complete the action.
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3.3.1.5  To add account information
WinCHAP includes very basic client account information that can keep track of 
any charges and payments associated with the client. This accounting informa-
tion basically works like a checkbook register. The client’s account balance is 
shown in the box below the list of available hearing aids.

To add a new transaction:

1.	 Click on the Client Services button below the list of available hearing 
aids in the lower right corner of the window. This will open the Client 
Services window shown in Figure 3.3.1.5.

2.	 Click Add to add a new record. This will open the data entry window. 

3.	 Choose whether the transaction is a charge or a payment.

4.	 Enter any relevant information such as the date, amount, and comments. 
If the transaction is a charge, enter a description of the service by using 
the Service Type pull-down list, or simply typing a short description into 
the provided box.

5.	 Click Save when done.

6.	 Click Back to close the data entry window. The new transaction will be 
displayed.

7.	 Click Back to close the Client Services window. The new balance will be 
shown in the Account Balance box.

Figure 3.3.1.5—The Client Services window
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3.3.2  Using the Hearing Aid Window
Hearing aids are organized in the WinCHAP database first by model name, and 
then by serial number. So, you can have many different aids with the same 
model name.

To enter a hearing aid into the WinCHAP database, first you enter the model 
name, and then you enter the individual serial number.

Figure 3.3.2—The Hearing Aid window

3.3.2.1  To enter a hearing aid model
1.	 Enter the Hearing Aid window (Figure 3.3.2) by clicking Hearing Aid in 

the left column of the Office Manager window. 

2.	 Click New in the top left corner of the window.

3.	 Enter the Model. This is a required field.

4.	 Enter any other desired information into the boxes provided.

5.	 Click Save in the top left corner of the window to save the model record.
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3.3.2.2  To enter an individual hearing aid
1.	 Locate an existing hearing aid model using the Search button (Section 

3.3.6.1) or enter a new model using the procedure described in Section 
3.3.2.1).

2.	 Click Add on the right side of the window to add a new serial number. 
This will open the Hearing Aid Information window. See Figure 3.3.2.2. 

3.	 Type in the Ear, Serial Number, and any other desired information. 
Serial Number is the only required field. 

4.	 Click Save in the Hearing Aid Information window to save the serial 
number.

5.	 Click New to enter a new serial number.

6.	 Click Back to close the Hearing Aid Information window. The new serial 
number should be listed.

Figure 3.3.2.2—Hearing aid information window

3.3.2.3  To attach a client
1.	 Find and highlight the individual hearing aid you would like to attach to 

a client. Use the Search button if necessary. (See Section 3.3.6.1.)

2.	 Click Edit to open the selected hearing aid. This will bring up the Hearing 
Aid Information window.
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3.	 Click Attach Client. This will bring up a client search window. See Figure 
3.3.2.3.

4.	 The current client will be automatically listed in the client search win-
dow. If you would like to attach the aid to a different client, type the 
client’s name into the appropriate boxes.

5.	 Select the client’s name to attach the hearing aid and close the search 
window.

6.	 Click Save to save your changes.

7.	 Click Back to close the Hearing Aid Information window.

Figure 3.3.2.3—Client Search window

3.3.2.4  To record hearing aid repairs:
You can create a hearing aid repair log for each individual hearing aid. This will 
record useful information such as when it was sent to the repair lab, when it 
was returned, and any comments you would like to make about the repair. See 
Figure 3.3.2.4A. Whenever a repair is recorded for a hearing aid, an asterisk will 
appear next to the aid’s listing, indicating the existence of the repair record.

1.	 Locate and highlight the hearing aid being repaired. Use the Search but-
ton if necessary. (See Section 3.3.6.1.)

2.	 Click Repair Info on the right side of the hearing aid list. This will open 
the repair record window.
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3.	 Enter the desired information into the provided boxes.

4.	 Click Save when satisfied. 

5.	 Click Back to return to the main Hearing Aid window. An asterisk will 
be displayed to the left of the aid listing, indicating the existence of the 
repair record.

If you want to see a spreadsheet list of all of the hearing aid repair histories, 
select Repair Records List in the Hearing Aid window. See Figure 3.3.2.4B. To 
refine the repair list, use the Criteria button. See Section 3.3.6.5.

Figure 3.3.2.4A—Hearing Aid Repair Record window



WinCHAP User’s Manual Office Management   31

Figure 3.3.2.4B—Repair Records List of all repairs

3.3.2.5  To delete a hearing aid model
This action deletes the hearing aid model and all individual hearing aids of that 
model.

1.	 Find the hearing aid model you would like to delete. Use the Search but-
ton if necessary. (See Section 3.3.6.1.)

2.	 Click Delete in the upper toolbar. A box will pop up to confirm your deci-
sion.

3.	 Click Yes to complete the deletion.

3.3.2.6  To delete an individual hearing aid
1.	 Locate and highlight the individual hearing aid you would like to delete. 

Use the Search icon if necessary. (See Section 3.3.6.1.)

2.	 Click Delete on the right side of the window. A box will pop up to con-
firm your decision.

3.	 Click Yes to confirm the deletion.
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3.3.2.7  To un-attach a client from a hearing aid
1.	 Locate and highlight the individual hearing aid record that you want to 

alter. Use the Search icon if necessary. (See Section 3.3.6.1.)

2.	 Click Edit to open the Hearing Aid Information window.

3.	 Click Remove Client.

4.	 Click Save and Back to return to the main Hearing Aid window.

3.3.3  Using the Manufacturer Window
The contact information for the manufacturers of your office equipment and 
hearing aids is managed in this window. There are fields for the company name, 
type, address information, phone number, and email, and general comments.

All manufacturers entered in this window will come up as choices in the manu-
facturer drop-down lists in the Hearing Aid and Test Instruments windows in 
the Office Manager.

Figure 3.3.3—The Manufacturer window

3.3.3.1  To create a manufacturer record
1.	 Enter the Manufacturer window (Figure 3.3.3) by selecting Manufacturer 

in the left column of the Office Manager window. 
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2.	 Click New in the top left corner of the window.

	 Note: If this is your first manufacturer record, you will automatically be 
in a blank manufacturer window; you can skip this step.

3.	 Enter the company Name (required field), Address, Phone Number, and 
any other information you would like to record about the manufacturer.

4.	 Click Save. Your record will now be saved.

You can click the Cancel button in the top left corner of the window to can-
cel the new record without saving.

3.3.3.2  To delete a manufacturer record
1.	 Find the manufacturer record you would like to delete. Use the Search 

button if necessary. (See Section 3.3.6.1.)

2.	 Click Delete in the upper toolbar. A box will pop up to confirm your deci-
sion.

3.	 Click Yes to complete the deletion.

3.3.4  Using the Test Instruments Window
The Test Instruments window gives you a place to store information about the 
test equipment you use in your office. You can record the instrument type, 
model, serial number, manufacturer, and calibration information. 

Figure 3.3.4—The Test Instruments window
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3.3.4.1  To create a test Instrument record
1.	 Enter the Test Instruments window (Figure 3.3.4) by selecting Test 

Instruments in the left column of the Office Manager window. 

2.	 Click New in the top left corner of the window.

	 Note: If this is your first test instrument record, you will automatically be 
in a blank test instrument window; you can skip this step.

3.	 Enter the Model and Serial Number (required fields), Address, and any 
other desired information. 

4.	 Click Save. Your record will now be saved.

You can click the Cancel button in the top left corner of the window to can-
cel the new record without saving.

3.3.4.2  To delete a test instrument record
1.	 Find the test instrument record you would like to delete. Use the Search 

button if necessary. (See Section 3.3.6.1.)

2.	 Click Delete in the upper toolbar. A box will pop up to confirm your deci-
sion.

3.	 Click Yes to complete the deletion.

3.3.5  Using the Personnel Window
This window organizes your personnel records. You can keep a record of your 
staff, their contact information, their job start dates, and their current positions 
as well as their social security numbers, their work titles and general comments.
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Figure 3.3.5—The Personnel window

3.3.5.1  To create a personnel record
1.	 Enter the Personnel window (Figure 3.3.5) by clicking Personnel in the 

left column of the Office Manager window. 

2.	 Click New in the top left corner of the window.

	 Note: If this is your first personnel record, you will automatically be in a 
blank test instrument window; you can skip this step.

3.	 Enter the First Name and Last Name (required fields), and any other 
desired information. 

4.	 Click Save. Your record will now be saved.

You can click the Cancel button in the top left corner of the window to can-
cel the new record without saving.

3.3.5.2  To delete personnel record
1.	 Find the personnel record you would like to delete. Use the Search but-

ton if necessary. (See Section 3.3.6.1.)

2.	 Click Delete in the upper toolbar. A box will pop up to confirm your deci-
sion.

3.	 Click Yes to complete the deletion.



36   Office Management WinCHAP User’s Manual	

3.3.6  Performing miscellaneous functions
Once you’ve entered your data, you can use WinCHAP to perform various 
reports that will help you search for particular records or sets of records. The 
Search, List, Sort, and arrow keys will assist you in accessing the data in a vari-
ety of ways.

All the functions described in this section work in each of the five sub-windows 
in the Office Manager. 

3.3.6.1  To search for a record
To bring up a particular record on your window in order to view it or edit it, use 
the Search button.

1.	 Click on the window containing the record type you would like to search: 
Client, Hearing Aid, Manufacturer, Test Instrument, or Personnel.

2.	 Click the Search button (represented by a pair of binoculors). A search 
window (Figure 3.3.2.3) will open 

3.	 Fill in the search criteria. As you type, a list of search results will appear 
in the list on the right side of the window.

4.	 Click the Search button to perform a search for your exact criteria.

5.	 To open a particular record, select it and then click Open. You can also 
double-click on the record.

Note: Clear List will erase the match list, and Clear Criteria will clear the 
information you entered.

3.3.6.2  To use the First, Previous, Next, and Last buttons
The First, Previous, Next, and Last buttons are represented as the four different 
arrow icons in the Office Manager toolbar. They are used to move from record to 
record through the list of client, hearing aid, manufacturer, test instrument, and 
personnel records. Their operation is fairly straight forward. 

1.	 Click the window containing the record type that you would like to 
scroll through: Client, Hearing Aid, Manufacturer, Test Instrument, or 
Personnel.

2.	 Click Previous and Next to go to the record immediately previous or 
immediately next to the displayed record. Click First or Last to go to the 
first and last records.

The order of the records is determined by the order in which the manufacturers 
are entered with new records going to the end of the list. To determine a new 
order, use the Sort button (Section 3.3.6.3).
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3.3.6.3  To sort the records
The Sort button is used to change the order of the list of records.

1.	 Click the window you would like to sort: Client, Hearing Aid, 
Manufacturer, Test Instrument, or Personnel.

2.	 Click Sort. This will bring up a sort window such as the one displayed in 
Figure 3.3.6.3.

3.	 In the left column, click on the field you want to use to sort.

4.	 Click Add. This will add the selected field to the Sort Order List column.

5.	 If desired, repeat steps 3-4 to further refine your sort.

6.	 Click either Ascending or Descending.

7.	 Click Sort. This will perform the sort.

8.	 Click Back to close the sort window.

Figure 3.3.6.3—The Hearing Aid Sort window

3.3.6.4  To list all records
The List button is used to list all records of the same type in a spreadsheet for-
mat. For instance, you can list all the client records. To list only records that ful-
fill a certain criteria, see Section 3.3.6.5.

1.	 Click the window you would like to list: Client, Hearing Aid, 
Manufacturer, Test Instrument, or Personnel.

2.	 Click List. This will open a spreadsheet of all the records from your 
selected window. See Figure 3.3.6.4 for a listing of hearing aid 

The list order is determined by the order in which the records are entered. To 
determine a new order, use the Sort button (Section 3.3.6.3).
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Figure 3.3.6.4—The Hearing Aid List window

3.3.6.5  To list specific records
When using the List command, you can refine your list criteria by using the 
Criteria button. For instance, you can list all clients within a certain area code.

1.	 Click on the window you would like to list: Client, Hearing Aid, 
Manufacturer, Test Instrument, or Personnel.

2.	 Click List. This will bring up a complete listing of all the selected record 
type.

3.	 Click Criteria. A new window will open. See Figure 3.3.6.5 for the Client 
Criteria window.

4.	 Look at the column of six criteria that correspond to the six columns 
in the List spreadsheet. These are the fields you can use to refine your 
record listing. For example, in the Client List window, you can use First 
Name, Last Name, Client #, Zip, Phone, and Last Visit.

5.	 Look at each criteria row. There are three empty fields in each row with 
an “operation” to the left of each one. These operations are used to specify 
how the entered criteria is used. For example, if you would like to list all 
client records in a specific zip code, you would choose the = operator in 
the Zip code criteria row, and input the desired zip code.

6.	 Enter the desired criteria into the appropriate box and choose the desired 
operation, as explained in Steps 4-5.
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Figure 3.3.6.5—The Client Criteria window

7.	 If you would like to specify more than one criteria, choose AND above the 
second criteria to specify a listing where both criteria are fulfilled at the 
same time. Choose OR to specify a listing in which one or the other crite-
ria is fulfilled.

8.	 Click Apply Query. This will run the specified criteria on the list. To fur-
ther refine your listing, repeat Steps 6-7. This will apply additional crite-
ria to your new, refined list. 

9.	 Click Reset Database to undo the criteria selection and return to the full 
listing of records.

10.	Click Back to close the Criteria window.

Example 1

To list all clients from the zip code “90210”, do the following:

1.	 Click the Client – Patient icon in the left column of the Office Manager.

2.	 Click List to bring up the listing of all clients in the database.

3.	 Click Criteria to bring up the Client Criteria window.

4.	 Input “90210” in the first empty box in the Zipcode row.

5.	 Choose “=” to the left of the zip code (this is the default selection).

6.	 Click Apply Query.
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7.	 Click Back. You will now see a listing of all clients from the entered 
zip code.

8.	 Click Print to print the spreadsheet listing.

Example 2

To list all hearing aids with a warranty expiration date ranging from January 
1, 2002 to April 1, 2002, do the following:

1.	 Click the Hearing Aid icon in the left column of the Office Manager.

2.	 Click List to bring up the listing of all hearing aids in the database.

3.	 Click Criteria to bring up the Hearing Aid Criteria window.

4.	 Input “2002/01/01” in the first empty box in the Warranty Date row.

5.	 Choose “>” to the left of the box you entered.

6.	 Click Apply Query. This will refine the listing to all warranty expira-
tion dates after January 1, 2002.

7.	 Replace “2002/01/01” with “2002/04/01 in the Warranty Date row.

8.	 Choose “<” to the left of the date.

9.	 Click Apply Query. This will refine the listing to all warranty expira-
tion dates before April 1, 2002.

10.	Click Back. You will now see a listing of all hearing aids with warranty 
expiration dates ranging from January 1, 2002 to April 1, 2002.

3.3.6.6  To add a picture to a file
You can add a picture to client records, hearing aid records, or personnel 
records. You will need to have scanned the photograph into your computer and 
saved it as a bitmap file. 

1.	 Click on the box where you would like to add the picture. A new window 
will open.

2.	 Find the directory where the picture file is stored. We recommend storing 
picture files in the WinCHAP UserPictures subdirectory.

3.	 Highlight the desired picture and click Open. The picture will load in the 
picture box. 

4.	 Click Save in the Office Manager toolbar to save the record with the pic-
ture in it.

5.	 Right-click on the picture box and select Remove Picture to remote the 
picture from the record.

Note: If you are using a WinCHAP database imported from an old version of 
WinCHAP that included client picture files, it may be necessary to reassign 
those pictures to the relevant client data files.
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Test Menu
The Test Menu is the window from which you can open any WinCHAP test. It is 
divided into two sub-windows: the Client-Patient window and the Hearing Aid 
window. 

The Client-Patient window lists all records in order by client. Any attached 
audiometric tests, DSL/NAL tests, or hearing aids are listed under the client 
record.

The Hearing Aid window lists all records in order by hearing aid model and 
serial number. Any saved hearing aid tests are listed under the hearing aid 
record. 

There are two ways to get to the Test Menu. 

•	 From WinCHAP’s Main Menu, click Test Menu. This will allow you to 
test any client or hearing aid entered in the Office Manager 

•	 From the Office Manager, click Test Menu in the toolbar. This will open 
the Test Menu and list only the client or hearing aid displayed in the 
Office Manager.

4.1  The Test Menu Display
The Test Menu contains records of all clients, hearing aids, and measurements 
saved in WinCHAP. There are two sub-windows: the Client-Patient window and 
the Hearing Aid window.

The Client-Patient window lists all records in order by the client attached 
to them. Whenever a client has a saved audiometric test, DSL/NAL test, or 
attached hearing aid, a PLUS (+) will appear to the left of his name. If you click 
it, the client’s record will open and display the attached list of tests and hearing 
aids. If the client has an attached hearing aid, that hearing aid listing may have 
a PLUS (+) next to it. Click it to open the hearing aid record containing the list-
ing of all tests attached to the aid. See Figure 4.1A.

The Hearing Aid window lists all records in order by the hearing aid attached to 
them. It works much like the Client-Patient listing; whenever a hearing aid has a 
saved test record, a PLUS (+) will appear to the left of its listing. If you click it, 
the hearing aid record will open and display the attached tests. See Figure 4.1B.

Both windows have the same basic format and share the same toolbar. 

•	 The left column of the window contains the Client-Patient and Hearing 
Aid icons that are used to switch back and forth between the two sub-
windows.
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•	 The middle column of the Test Menu displays details of the current 
selected record. In the Client-Patient window, the middle column displays 
basic information about the selected client. In the Hearing Aid window, 
the middle column displays basic information about the selected hearing 
aid.

•	 The right column of the window contains the client or hearing aid record 
listing. Groups of twenty records are displayed together at one time. Move 
between the groups of records by using the First, Previous, Next, and Last 
arrow keys in the Test Menu toolbar.

Figure 4.1A—Client-Patient view
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Figure 4.1B—Hearing aid view

4.1.1  Moving between records
All of the client and hearing aid records saved in the WinCHAP database are 
sorted into groups of thirty. Only one group of thirty is displayed in the Test 
Menu at a time.

To scroll through the different groups, use the First, Previous, Next, and Last 
arrow buttons.

•	 First lists the first thirty records in the database

•	 Previous goes back one group of thirty records

•	 Next goes to the next group of thirty records

•	 Last lists the last thirty records in the database
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4.1.2  Changing the order of the records
The Sort button is used to change the order of the displayed records. 

1.	 Enter the Test Menu.

2.	 Click the window that you would like to sort: Client-Patient or Hearing 
Aid.

3.	 Click Sort.

4.	 Double-click the desired Table Field you would like to sort by. This will 
move the field to the Sort Order List column.

5.	 Choose to have an Ascending or a Descending sort.

6.	 Click Sort to complete the sort.

7.	 Click Save Settings to save the sort order as the default order.

4.1.3  Finding a record
The Search icon is used to find specific client or hearing aid records.

1.	 Enter the Test Menu.

2.	 Select the type of record you are looking for: Client-Patient or Hearing 
Aid.

3.	 Click Search. This button is represented by a pair of binoculars in the 
Test Menu toolbar.

4.	 Input the criteria for which you want to search.

5.	 Double-click on the record in the list of search results to view it in the 
Test Menu.

4.1.4  Editing a record
To edit the details of a client or hearing aid record, you must go to the Office 
Manager. You can do this directly from the Test Menu.

1.	 Find the record you want to edit. See Section 4.1.3.

2.	 Click Office in the Test Menu toolbar. This will open the Office Manager 
to the selected record.

3.	 Make any desired changes to the record.

4.	 Click Save in the Office Manager.

5.	 Click Back in the Office Manager to close it and return to the Test Menu.

4.1.5  Displaying all records
When you use the Search function, or you enter the Test Menu from the Office 
Manager, the records listing in the right column will narrow to the selected 
record. To reset this list to include all records (in groups of 30), click Reset List 
in the Test Menu toolbar.
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4.2  WinCHAP Measurements
Each measurement window in WinCHAP is either attached to the hearing aid, 
or it is attached to the client:

•	 Client: Audiometric Test, DSL/NAL Test.

•	 Hearing Aid: ANSI 03, ANSI 96, ANSI 87, ANSI 92, ACIC, IEC, JIS, 
Response Curves, and Real Ear.

4.2.1  Creating a client test
1.	 Click Client-Patient in the left column of the Test Menu to enter the 

Client-Patient window.

2.	 Locate the record of the client that you want to test. Use the Search but-
ton if necessary. (See Section 4.1.2.3.)

3.	 Click the name of the client in the right column of the Test Menu. This 
will bring up a window containing the client test options.

4.	 Double-click the test you would like to create. See Chapter 5 for details 
on using the Audiometric Test window, and Chapter 7 for details on using 
the DSL/NAL Test window.

4.2.2  Creating a hearing aid test
1.	 Locate the record of the hearing aid that you want to test. If the hearing 

aid is attached to a client, it might be more convenient to find the client 
record and click the PLUS (+) next to his name. This will display all tests 
and hearing aids attached to that client.

2.	 Double-click the hearing aid record in the right column of the Test Menu. 
This will bring up a window containing all the hearing aid test options.

3.	 Double-click the test you would like to create. See Chapter 6 for details 
on using the hearing aid testing windows.

4.2.3  Opening an existing test
1.	 Locate the hearing aid or client record to which the test is attached.

2.	 Click the PLUS (+) next to the client or hearing aid record. This will 
list all attached tests. (If you are viewing a client record, you may see an 
additional PLUS (+) next to any hearing aid attached to that client. Click 
it to view the tests saved to that hearing aid.)

3.	 Double-click the existing test to open it.

4.2.4  Deleting a test
You can delete any measurement attached to a hearing aid or client. Entire hear-
ing aid or client records must be deleted in the Office Manager.

1.	 Select the test you would like to delete.

2.	 Click the Delete button in the Test Menu toolbar.
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Audiometric Test 
The Audiometric Test window stores all of the client’s audiometric information. 
It also provides a remote, computer-based interface to a connected FONIX audi-
ometer. The information available in the Audiometric Test window has been 
organized into six different sub-windows, each of which is accessible by click-
ing on the appropriate icon on the left side of the main window. They are:

•	 Audiometric Curves: Graphical display for air, bone, aided & unaided, 
and other miscellaneous audiometric measurements. Also contains inter-
face for remote operation and data collection from a FONIX audiometer.

•	 Curve Data Values: Numeric display of the air and bone data graphically 
displayed in the Audiometric Curves sub-window.

•	 Speech Audiometry: Place to store speech audiometry and speech dis-
crimination measurements.

•	 Sound Field Audiometry: Numeric display of the aided & unaided data 
graphically displayed in the Audiometry Curves sub-window.

•	 Impedance: Place to store impedance measurements. Note: FONIX audi-
ometers are not capable of these measurements.

•	 Client & Test Info: Display of basic information about the client and test 
such as name, birthday, date & time of the test. Also shows any hearing 
aids attached to the client. Hearing aid tests can be created from this win-
dow by highlighting a listed hearing aid and clicking the Test Hearing Aid 
button.

Each of these sub-windows share a toolbar and menus.

To open the Audiometric Test window, follow the instructions found in Section 
4.1.3.1 and choose to open Audiometric Test in Step 4.

See Section 5.5 for information on sending an insertion gain target to your ana-
lyzer and opening a hearing aid test window.

5.1  Introduction
This section describes how to start an audiometric test, open a saved test, check 
your audiometer’s connection, and other basic features.

5.1.1  Starting a new test
All Audiometric Tests are tied to a client record. To create a new test:

1.	 Create a client file for your client, if you haven’t already done so. See 
Section 3.2.1.1 or 3.3.1.1.
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2. 	 Enter the Test Menu window by clicking Test Menu from the Main window.

3. 	 Search for your client record. See Section 4.1.3.

4. 	 Select your client’s name in the right column of the Test Menu. This will 
open the Client Tests window.

5. 	 Select Audiometric Test. This will open the Audiometric Test window 
and start a new test.

5.1.2  Opening an existing test
To open a previously saved Audiometric Test:

1. 	 Enter the Test Menu by clicking Test Menu from the Main window.

2.	 Search for your client record. See Section 4.1.3.

3. 	 Click the PLUS (+) to the left of the client’s name in the right column of 
the Test Menu. This will display any audiometric tests saved to that client 
record. If there is no PLUS (+) next to the client’s name, no audiometric 
tests have been saved for that client.

4. 	 Open the desired test by clicking on it.

5.1.3  Checking your connection
Before you can get any measurement curves from your FONIX audiometer, your 
computer must be connected to your audiometer. See Section 1.3.

Click the Check button located in the toolbar to confirm your audiometer’s 
connection. You can also open the Tools menu and select Check Audiometer 
Connection. This will establish whether or not a successful connection had 
been made from the computer to the audiometer. If successful, the Talk 
Forward button will appear in the Audiometric Curves window.

To change the COM port used for the audiometer connection:

1. 	 Open the Tools menu from the Audiometric Test window and select 
FONIX Communication Setup. This will open the Communications Setup 
window.

2.	 Select the COM port used by your FONIX audiometer in the appropriate 
drop-down list.

3.	 Click the Check Audiometer button to verify your connection.

4.	 Click Save Settings.

5.	 Click Back to exit the window.

5.1.4  Setting details about the test
The Client & Test Info window displays the name and birth date of the client 
and the date and time of the audiometric test.  If desired, you can specify the 
operator of the audiometric test and the audiometer that was used by clicking 
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on the pull-down lists.  Those pull-down lists will contain all the operators and 
audiometers entered into the database as described in Section 3.3.4 and Section 
3.3.5, respectively.

5.1.5  Printing audiometric information
Use the Print button in the toolbar to print the audiometric information.

1.	 Click the Print button in the toolbar. A print window will open.

2.	 Choose the type of data you want to print.

	 •	 Print Test Curves will print the audiometric curves 
•	 Print Test Data will print the numerical test curve data 
•	 Print SF and Speech Data will print the data from the Sound Field 		
	 Audiometry window

3.	 Click Print. The will start the printing of the data.

5.1.6  Talking to your client
When the Check button is clicked and a successful connection has been con-
firmed, the Talk Forward button will appear in the Audiometric Curves win-
dow. Click and hold this button in order to activate the Talk Forward feature 
on the audiometer. When you speak into the audiometer’s microphones (goose-
neck, internal, or boom), your voice will be carried into the patient’s transducer 
(sound field speakers, insert earphones, or TDH headphones). This feature 
is used for instructing the patient inside a sound booth, NOT for performing 
speech measurements.

5.2  Pure-tone and Bone Testing
The Audiometric Curves (Figure 5.2), Curve Data Values, and Sound Field 
Audiometry windows are used to perform pure-tone air (with or without mask-
ing) and bone audiometric testing. You can input the following data into these 
windows:

•	 Air conduction HTL 

•	 Masked air conduction 

•	 Bone conduction HTL 

•	 Masked bone conduction

•	 Uncomfortable levels 

•	 Unaided,

•	 Aided

•	 Target

•	 Other 
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The Audiometric Curves window contains the graphical display of this data 
while the Curve Data Values and Speech Audiometry windows contain the 
numerical displays.

Figure 5.2—Audiometric curves

In the Audiometric Curves graphical display, these curves are listed in a leg-
end below each graph. There is a box next to each curve. Selecting a curve will 
mark the box with an “x” and display the curve on the graph. Deselecting the 
curve will turn off its display but will not delete it.

5.2.1 Capturing tests from the audiometer
The Connect button is used to establish a real-time connection between your 
audiometer and your computer. When you use it, you will operate the audiom-
eter as usual by using its knobs and buttons. Whenever you push the stimulus 
button on your audiometer, the graph marker on your WinCHAP display will 
automatically be updated with the selected frequency and amplitude. The type 
of test that is recorded is dependent upon the position of the input and output 
dials on your audiometer. See Table 5.2.1.

Note: The Connect button is NOT used to remotely control the audiometer from 
the computer. See Section 5.2.4 for more details.
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To capture an audiometric test:

1. 	 Set up the audiometer as usual to run the desired test. 

2.	 Click CONNECT in the Audiometric Test toolbar.

3.	 Administer the test. WinCHAP will automatically display the test results 
as you run through the different frequencies on the audiometer. The test 
results will be recorded as indicated in Table 5.2.1.

4.	 Click DISCONNECT when done.

5.	 Click Save to store results.

TABLE 5.2.1

Recorded as Tested Ear Other Ear

Air Conduction HTL (UCL) Input: tone no stimulus
 Output: phone 

Masked Air Conduction Input: tone Input: NBN
 Output: phone Output: phone 

Bone Conduction HTL Input: tone no stimulus
 Output: bone 

Masked Bone Conduction Input: tone Input: NBN
 Output: bone Output: phone

Unaided (Aided) Input: tone no stimulus
 Output: speaker

Several different types of data share the same testing conditions. That is, HTL 
and UCL both use an input of tone and an output of phone. Likewise, Unaided 
and Aided both use an input of tone and an output of speaker. 

To capture data into the UCL slot, select it manually in the WinCHAP screen, 
make sure the Connect button is active, and return to your audiometer using 
the tone/phone selections. Any data captured will be saved into the UCL slot 
instead of the HTL slot. To capture data in the Aided slot, select it manually and 
perform your testing at the audiometer with the tone/speaker selections. 

5.2.2  Using the Patient Response Button
When capturing tests from your FONIX audiometer (Section 5.2.1), you can set 
the audiometer to respond to the patient response button in the following man-
ner: whenever a signal is presented, the WinCHAP display will update with an 
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appropriate symbol placed at the specified frequency and amplitude. This sym-
bol will include the no-response diagonal arrow, specifying that the patient has 
not yet responded to it. When the patient pushes the patient response button 
while the signal is being presented, the no-response diagonal arrow will disap-
pear, leaving a normal audiometric symbol on the WinCHAP display.

The patient response button update only works when a stimulus is being 
presented. If the patient pushes the button when there is no stimulus, the 
WinCHAP display will not be updated.

To use the patient response button:

1.	 Open the Settings menu, point at Patient Response Button, and select ON.

2.	 Click Connect to establish a real-time connection to your audiometer.

3.	 Go to your FONIX audiometer and administer the test. When you present 
the stimulus, a no-response button will appear on the WinCHAP display. 
When the patient pushes the button while a stimulus is being presented, 
this no-response symbol will change into a normal response.

5.2.3  Recording a No Response
There are two ways to record a no response in an Audiometric Test: 

•	 You can use the patient response switch to automatically record each 
stimulus without a patient response as a no response, as described in 
Section 5.2.2, or 

•	 You can input the no response manually in the Curve Data Values window 
by inputting input an * symbol at the desired frequency. To input the no 
response at a specific amplitude, just add the * symbol to that amplitude. 
For instance, use “*100” to input a no-response at 100 dB HL. When you 
go back to the Audiometric Curves window and click Refresh, the no 
response symbol should appear. 

5.2.4  Remotely controlling your audiometer 
You can remotely control many of the functions of your FONIX audiometer 
from the Audiometric Test window, including the Input, Output, Hearing Aid 
Simulator settings. You can also remotely present a tone with the frequency and 
amplitude of your choice.

In the following instructions, steps 1-4 describe how to remotely set the audi-
ometer’s Input, Output, and Hearing Aid Simulator settings. When you do this, 
these new settings override the manual knob controls on the audiometer. If you 
do not perform these steps, WinCHAP will use the manual knob controls set-
tings to determining the type of signal to present.
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1. 	 (optional) Open the Settings menu, point to Audiometer Settings, and 
select Audiometer Control Panel. See Figure 5.2.4.

2. 	 (optional) Select the desired Output, Input, and Aid Simulator settings 
for each ear. You can also turn on and off Pulsed, Warbled, and Output 
Reverse. 

3.	 (optional) Click Set Audiometer to enable your selections.

4.	 (optional) Click Back to close the Audiometer Control Panel.

5.	 Right-click on the audiogram graph at the desired frequency and ampli-
tude. The tone will be presented for the length of your click; hold your 
right-mouse button down for longer tone presentations. While the signal 
is being presented, the stimulus circle in the middle of the Audiometric 
Curves window will turn green.

6.	 Administer the test in this fashion and click Save to save the results.

Figure 5.2.4—Audiometer Control Panel

5.2.5 Manually entering audiograms
1.	 Choose the curve by selecting it in the list below the graph. A checkmark 

will appear next to it when it is selected.

2.	 Use the mouse to enter the values on the graph by pointing and clicking 
at points you want marked. Alternately, go to the Curve Data Values win-
dow and input the numerical audiometric values.

3.	 Click Save to store results.
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5.2.6  Copying ears, Deleting data, and Changing the display
There are a few miscellaneous functions you can perform in the Audiometric 
Curves window.

•	 Use the Copy L→R button to copy all audiometric data from the left ear to 
the right ear.

•	 Use the Copy R→L button to copy all audiometric data from the right ear 
to the left ear.

•	 Use the Refresh button to refresh the graphics on the window.

•	 Use the Delete button (represented by a recycle bin in the toolbar) to 
delete all test curves. If you would like to selective data, click on the 
arrow next to the Delete button and choose the desired function. You 
can delete the selected right or left curve, all the right curves, all the left 
curves, or all curves.

There are several ways to change the display of the window. Open the Settings 
menu and point to Graphic Settings. You will see the following selections:

•	 Symbols: Turn ON and OFF the display of the curve symbols on the 
audiometric graphs.

•	 Grid: Turn ON and OFF the display of the grid lines on the audiometric 
graphs.

You can also choose between using US audiometric symbols and UK 
audiometric symbols. To do this, open the Settings menu, point to Graphic 
Settings, point to Symbols, and select Symbols Type. This will open the Print 
Configuration window. Changing the Audiometric Symbols setting in the 
General tab will also change the symbols used in the Audiometric Curves 
graph.

5.2.7 Changing the curve colors
You can change the curve colors used in the Audiometric Curves window. To do 
this:

1. 	 Open the View menu and point to Color Palette.

2. 	 Select Right Ear Curve Colors or Left Ear Curve Colors. This will open 
the Curve Colors window.

3.	 Select the curve you want to change in the List of Curves box.

4.	 Click Select Curve Color. This will open the Color Palette window.

5.	 Choose one of the Basic Colors and click OK, or click Define Custom 
Colors to open the Custom Color Palette window.

To define a custom color:

1.	 Follow the instructions above to open the Custom Color Palette window.
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2. 	 Select the desired color in the color box.

3. 	 Select the desired shade of the color in the shade box, just to the right 
of the custom color box. The actual selected color will be shown in the 
Color/Shade box.

4. 	 Click Add to Custom Colors to add the selected color to one of the 
Custom Colors boxes.

5.	 Select the new custom color in the Custom Colors box.

6.	 Click OK.

Click Save Settings to save the new color selection as the default setting.

Click Reset Colors to return colors to their factory default settings.

5.3  Speech Audiometry
In the Speech Audiometry window, you can record values for measurements 
made using earphones or a sound field. See Figure 5.3. When entering earphone 
measurements you can distinguish among measurements made with left ear, 
right ear, and both ears. The sound field measurements have fields for both 
unaided and aided values.

For each type of measurement, you can enter values for speech reception thresh-
olds and corresponding masking levels, uncomfortable levels, most comfortable 
levels, and word discrimination scores and corresponding masking levels. You 
can also note the word list and method used to attain scores.

Figure 5.3—Speech Audiometry window
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5.4  Impedance
Impedance is a measurement of how sound energy flows through the middle 
ear. Although FONIX equipment does not measure impedance, if you have per-
formed the measurements with an impedance audiometer, you can store the 
data here. When importing data from NOAH 3 (See Chapter 8), any impedance 
data saved to the patient’s record will be transferred to this window.

Figure 5.4—Impedance

5.5  Hearing Aid Analyzer Functions
From the Audiometric Test window, you can generate a target (NAL-R, POGO, 
BERGER, 1/3 Gain, 1/2 Gain, or 2/3 Gain), send it to a connected FONIX ana-
lyzer, and start a hearing aid test.

5.5.1 Generating a target
1.	 Click on the Target button. A new window will open (Figure 5.5.1).

2.	 Select whether you would like to use the left or the right audiometric 
curve when generating a target. 

3.	 Select the desired fit rule.

4.	 Click Create Target Curve. A message will open verifying the successful 
creation of the target curve.
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5.	 Click Send RIGHT Ear Target Curve to Analyzer or Send LEFT Ear 
Target Curve to Analyzer. This will send the insertion gain target to your 
connected FONIX analyzer.

6.	 Click Back to exit the target window. 

Figure 5.5.1—Creating a target

5.5.2  Sending an audiogram to the analyzer
If you are using the FONIX 7000 or FP35 analyzer, you can send the WinCHAP 
audiogram to your analyzer. To do this, right click on the audiogram you want 
to send in the Audiometric Curves window and select Send (curve name) to the 
analyzer. This will send the audiogram to the analyzer. You will have to push 
the suitable buttons on the analyzer to actually generate a target. See your ana-
lyzer’s Operator’s Manual for more details on generating a target.

This feature is not available on the 6500-CX or FP40 analyzers.

5.5.3  Starting a hearing aid test
If you have assigned hearing aids to your client (as described in Section 3.2.2.2 
and Section 3.3.2.3), you can go directly to a hearing aid test window from the 
Client & Test Info window.

1.	 Click Client & Test Info in the left column of the window.

2.	 Look at the bottom half of the Client & Test Info window. You will see a 
list of hearing aids attached to the client.

3.	 Double-click on the hearing aid you would like to test. This will open the 
hearing aid test selection window.

4.	 Choose the test you would like to perform. The testing window will open.





Chapter 6 59

The DSL/NAL-NL1 Module
The DSL/NAL-NL1 test window was designed to help fit non-linear hearing aids 
according to the DSL or NAL-NL1 fitting formulas. Both formulas are highly 
adaptable and have many different settings that will allow you to fine-tune your 
hearing aid fittings. 

The University of Western Ontario developed the Desired Sensation Level (DSL) 
method of hearing aid fitting. The goal of the DSL method is to make amplified 
speech audible. The DSL method differs from many traditional methods; it uses 
an SPL-o-gram rather than insertion gain and, when necessary, incorporates 2-cc 
coupler measurements made in the sound chamber into the hearing aid fitting. 
DSL was originally designed to expedite fitting hearing aids for young children 
and to improve the accuracy of those fittings. 

The NAL-NL1 fitting formula is the natural non-linear extension to the NAL-
R linear formula that has been dominant in the hearing aid industry for many 
years. NAL-NL1 is based on insertion gain measurements, and it takes into 
account many factors including the number of channels of the hearing aid, 
whether the patient has a binaural or monaural fitting, and even what type of 
output limiting is present on the hearing aid.

To enter the DSL/NAL-NL1 test window:

1.	 Click Test Menu in the Main Menu.

2.	 Locate the client you want to test. See Section 4.1.3.

3.	 Select the client’s name in the right column of the Test Menu. This will 
bring up the client test selection window.

4.	 Choose DSL/NAL-NL1 Test.

The DSL/NAL-NL1 test has four windows: The Audiometry window, DSL win-
dow, NAL-NL1 window, and the Info window. The Audiometry window is used 
to input audiometric information such as thresholds and upper limit values. You 
can also use it to perform RECD and REDD transforms or input existing data. 
The DSL and NAL-NL1 windows are used for taking real-ear and coupler mea-
surements and compare them to the displayed targets. The Info window records 
the date the test is taken, the clinician performing the fitting, and the equipment 
used to take the measurements. The DSL 2-cc coupler derivations are also dis-
played in this window; they are generally used when ordering a hearing aid to 
match the patient’s hearing loss.

6.1 General Information
General operations of the DSL/NAL-NL1 test such as opening existing tests, 
creating new tests, changing clients, printing results, and saving defaults are 
described in this section.
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6.1.1 Opening an existing test
There are a couple of different ways to open an existing test. The easiest way is 
to open the test from the Test Menu:

1.	 Locate your patient in the Test Menu. See Section 4.1.3.

2.	 Click the PLUS (+) button next to the patient’s name to display any exist-
ing tests that have been saved for that patient.

3.	 Find the DSL/NAL-NL1 test listing and double-click it. This will open the 
existing test.

If you have the DSL/NAL-NL1 test window open, and you would like to open 
another existing test for the same patient:

1.	 Click Open in the DSL/NAL-NL1 toolbar. Alternately, select Open in the 
File menu. This will open a listing of all saved DSL/NAL-NL1 tests for 
that client. See Figure 6.1.1.

2.	 Select the test you would like to open.

3.	 Click Open to open the test.

Figure 6.1.1—Open an existing DSL/NAL-NL1 test

6.1.2 Creating a new test
When you open the DSL/NAL-NL1 test by using the directions described in the 
introduction above, a new test is automatically started. If you would like to start 
a new test without closing the DSL/NAL-NL1 test, use the New button in the 
toolbar. Alternately, you can select New in the File menu, or just push the F1 
key.

When a new DSL/NAL-NL1 test is created, the threshold and upper limit values 
are copied to the new test, but the measurements are not copied. If you would 
like to create a new test without copying the audiometric values, select New 
(Empty) in the File menu.
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6.1.3 Changing the client
If you want to change the client being tested without exiting from the DSL/NAL-
NL1 test, use the Search button.

1.	 Click Search in the DSL/NAL-NL1 toolbar. A pair of binoculars represents 
this button. This will bring up a client search window. See Figure 6.1.3.

2.	 Enter the client’s name (or other search criteria) into the provided boxes. 
As you enter the criteria, the search results will appear.

3.	 Select the client’s listing and click Open.

Figure 6.1.3—Client Search window

6.1.4 Printing results
Use the Print button to print the DSL/NAL-NL1 test results.

1.	 Go to the window you would like the print (normally the DSL or NAL-
NL1 windows).

2.	 Click Print in the DSL/NAL-NL1 toolbar. This button is represented as a 
picture of a printer. The Print window will open. See Figure 6.1.4.

3.	 Choose whether you want to print the graphical curves (Print Test) and/or 
numerical data (Print numerical data).

4.	 Click Configure Header if you want to change the header located at the 
top of the printout. Click Back to close the configure window.

5.	 Click Print to start printing.
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Figure 6.1.4—DSL/NAL-NL1 Print window

6.1.5 Deleting data
The Delete button, represented by a picture of a recycle bin in the DSL/NAL-
NL1 toolbar, is used to delete the test data and audiometric curves. To use it, 
first enter the window containing the data you would like to delete.

•	 To delete the current selected curve, click the Delete icon represented by 
a picture of recycle bin.

•	 To delete all curves all curves in the window, click the arrow to the right 
of the Delete button to open the delete choices. Choose the option that 
will delete all curves in the window.

•	 To clear all curves from the current graph (without deleting them perma-
nently), click the arrow to the right of the Delete button to open the delete 
choices. Choose Clear current graph.

6.1.6 Using the DSL/NAL-NL1 Settings window
Enter the DSL/NAL-NL1 Settings window by clicking the Settings button. See 
Figure 6.1.6. In this window, you can set many of the parameters used in the 
DSL and NAL-NL1 fitting formulas. 

See Section 6.6 for a complete explanation of all available settings.
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Figure 6.1.6: Settings window

6.1.7 Customizing Settings
The DSL and NAL-NL1 fitting protocols can be fairly complicated fitting pro-
cesses with a variety of settings and variables that can affect the targets. For this 
reason, we make it possible to customize the settings for the particular client as 
well as save new default settings for the program as a whole.

1.	 Click Settings to open the Settings window. See Figure 6.1.6.

2.	 Configure your desired settings.

3.	 Click Save to save these settings as the client’s customized settings.

4.	 Open the Tools menu and select Save as Default Settings to save these 
settings as the general default settings that are used for all clients. (Any 
client with custom settings will retain their custom settings.)
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6.1.8 Changing the curve colors
You can change the curve colors in the Audiometry, DSL, and NAL windows.

To set the curve colors:

1.	 Open the View menu, point at Color Palette, and select NAL, DSL, or 
Audiometry.

2.	 Select the curve you want to change. This will open the Color window.

3.	 Select the color you want to use by either choosing from the preset basic 
colors, or by defining your own custom color by clicking on the color 
map to select the custom color and then clicking Add to Custom Colors.

4.	 Click OK to complete the selection and close the Colors window.

5.	 Click Apply Changes to apply the changes only to the current test. Click 
Save Settings to apply the changes as the new default colors.

6.	 Click Back to close the Curve Colors window.

To reset the colors to their factory default setting, open the Curve Colors win-
dow and click Reset Colors.

6.1.9 Other functions
•	 Use the Check button to check the connection between your computer and 

your FONIX analyzer and/or audiometer.

•	 Use the Refresh button to refresh the graphics on your window and update 
any changes you may have made.

•	 Use the Copy Ear button to copy audiometric data from the current ear to the 
other ear. Verification data will not be copied.

6.2 Audiometry
The first step in a hearing aid fitting is to obtain the patient’s audiometric infor-
mation. These can include hearing threshold levels (HTL), bone conduction 
values, uncomfortable levels (UCL), and audiometric transforms. All of these 
measurements can be stored in the Audiometry window. Some values, such as 
the UCL and transform values, can be predicted from the patients HTLs and age. 
See Figure 6.2.
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Figure 6.2—The Audiometry window

6.2.1 Entering threshold data
There are two ways to enter audiometric data: you can use the graph and your 
mouse to “click in” your values, or you can use the numerical tables at the bot-
tom of the window and enter the values manually.

6.2.1.1 To use the assessment graph
1.	 Enter the Audiometry window by clicking the Audiometry icon in the left 

column of the DSL/NAL-NL1 test.

2.	 Click Settings and select the General tab.

3.	 Select the Transducer used to make the audiometric measurements. If a 
loud speaker was used, also select the Loud Speaker Orientation. This 
should also be the orientation that you use for any real-ear measurements.

4.	 Click Back to close the Settings window.

5.	 Make sure AC Threshold is selected in the legend to the right of the 
Assessment Data graph. It should have a small black check to the left of 
the listing.

6.	 Use your mouse to input the amplitude for each frequency on the graph.

7.	 Click Save in the toolbar to save the results.
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6.2.1.2 To use the audiometry table
1.	 Follow steps 1-4 in the previous section.

2.	 Select the appropriate column in the Audiometric Information table in the 
lower half of the Audiometry window.

3.	 Enter the amplitude data in the boxes corresponding to the appropriate 
frequencies. Use your Enter key to move between fields.

4.	 Click Save in the toolbar to save the results.

6.2.2 Entering/Predicting Upper Limit values
The AC Upper Limit values are defined as the client’s upper limits of comfort. 
You can choose to have WinCHAP predict these values, based upon the client’s 
age and entered thresholds, or you can enter measured values. WinCHAP uses 
the DSL method to make these predictions.

Choose between Predicted or Measured in the Upper Limit box to the right 
of the Assessment Data graph. Measured upper limit values are entered in the 
same manner as threshold values. See Section 6.2.1.

6.2.3 Entering Bone Conduction values
Bone conduction values are entered in the same manner as threshold values. If 
entered, NAL-NL1 uses them in creating measurement targets. DSL does not use 
these values.

6.2.4 Performing or Predicting an RECD measurement
The real-ear to coupler difference (RECD) measurement finds the acoustical dif-
ference between a 2-cc coupler and your patient’s ear. The DSL and NAL-NL1 
formulas take these differences and create realistic coupler target curves. This is 
particularly useful when fitting babies and small children who don’t allow you 
to take an actual real-ear measurement.

To predict the RECD based on the patient’s age, selected Predicted in the RECD 
box in the Audiometry window. The predicted RECD (as well as the predicted 
REUR and REDD) values are displayed in column format on the bottom half of 
the window. DSL and NAL use different predictions for these transforms in their 
fitting formulas; the Settings window lets you set which prediction values are 
displayed.

To measure the RECD, select Measured in the RECD box and follow the instruc-
tions in the following sections.

6.2.4.1 To perform the coupler measurement
This section describes how to perform the coupler part of the RECD measure-
ment. The procedure is different for the 6500-CX and FP40 than for the FP35 
and 7000 analyzers.
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The DSL and NAL methods for performing RECD measurements are slightly 
different. DSL recommends performing all RECD measurements using an HA-2 
coupler, even when fitting a canal-type aid that would normally be tested with 
an HA-1 coupler; DSL automatically compensates for the acoustical difference 
between the couplers. 

NAL recommends performing the RECD measurement using the coupler that 
will be later used for performing coupler measurements. That is, when fitting a 
BTE aid, use an HA-2 coupler for the RECD. When fitting a canal aid such as an 
ITE, ITC, or CIC, use an HA-1 coupler. Unlike DSL, NAL doesn’t compensate for 
the difference between the HA-1 and HA-2 couplers.

FP40 and 6500-CX Analyzer
The coupler measurement part of the RECD is taken with a 50 Ohm insert ear-
phone plugged into the external speaker jack of the FP40 or 6500 hearing aid 
analyzer. Once this measurement has been taken, it will automatically be used 
for all future RECD measurements, even those taken with different clients. 

1.	 Connect the insert earphone to the appropriate coupler. There are several 
different possible methods. Use the method most appropriate for your fit-
ting.

•	 BTE without custom mold available and ITE/Canal per DSL specs: 
Connect the insert earphone directly to the ear level adapter on an 
HA-2 coupler. 

•	 BTE with custom mold: Connect the insert earphone to the patient’s 
custom ear mold, and use putty to connect the ear mold to the HA-1 
coupler. 

•	 ITE/Canal per NAL specs: Connect the insert earphone to an HA-1 
coupler using a foam ear tip and Fun Tak. 

2.	 Thread a probe tube through the probe calibration adapter. The tip of the 
probe tube should extend no more than three millimeters past the non-
ridged end of the adapter. Fix the probe tube in place at its entry point, 
with a bit of Fun-Tak. See Figure 6.2.4.1A.

3.	 Push the probe calibration adapter into the coupler.

4.	 Plug the insert earphone into the external speaker jack on the back of the 
analyzer.

5.	 Click Get RECD in the Audiometry window. This will open the RECD 
measurement window. See Figure 6.2.4.1B.

6.	 Select Coupler.

7.	 Select the source level by using the arrow buttons located to the left of 
the Coupler button. The default level of 70 dB SPL is recommended.

8.	 Click Start Test. The coupler measurement will be performed.
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FP40 users should note that the WinCHAP RECD procedure differs from the 
FP40’s built-in RECD procedure. 

Probe calibrator
adapter

HA-2
Coupler

Putty to hold probe
tube in place

Probe mic

To 3A
insert earphone

Not more than
3mm

25 mm
(I.D. 1.93 mm)

Use tape or putty to
seal this connection

Ear level adapter

Figure 6.2.4.1A—Coupling of the probe microphone to the insert earphone using an HA-2 
coupler.

Figure 6.2.4.1B—RECD Measurement window
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FP35 and 7000 Analyzers 
The coupler measurement part of the RECD on the FP35 and 7000 analyzers is 
made according to the calibration procedure described in the Operator’s Manual 
of the analyzer. WinCHAP merely gathers this data when the real-ear part of the 
RECD measurement is performed.

6.2.4.2 To perform the real-ear measurement (all analyzers)
1.	 Position the earhook on the client’s ear. Attach the probe microphone to 

the earhook. The reference microphone is not used in this measurement.

2.	 Insert probe tube into client’s ear. 

3.	 Insert the client’s custom earmold or a foam eartip into the client’s ear. 
Attach the insert earphone. See Figure 6.2.4.2.

4.	 Open the RECD measurement window by clicking the RECD button in the 
Audiometry window.

5.	 Select Real-Ear in the RECD measurement window. 

6.	 If you are using the 6500-CX or FP40, you can select the source level  by 
using the arrow buttons located to the left of the Real-Ear button.. The 
default level of 70 dB SPL is recommended, but you should select the 
level that was used for the coupler measurement. You cannot change the 
source level used with the 7000 and FP35 analyzers; those analyzers will 
always use 70 dB SPL.

6.	 Click Start Test. This will start the pure-tone measurement sweep.

7.	 Click Save Test to store the test results.

8.	 Click Back to close the RECD window. If you performed the coupler mea-
surement, you will be asked if you wish to save it for future use. If you 
click Yes, the measurement will be automatically appear the next time 
you perform an RECD, even with another patient.

9.	 Make sure Measured is selected next to the RECD button.

10.	Click Settings to open the Settings window. 

•	 Under the General tab, the Transducer should be set to Insert 
Earphone or Insert Custom Mold, depending upon whether you 
used a custom mold.  

•	 Under the NAL-NL1 tab, in the Measured RECD selection, choose 
HA-1 if you used an HA-1 coupler without a custom ear mold, or 
choose HA-2/own mold if you used an HA-2 coupler or an HA-1 
with a custom ear mold in the measurement.

11.	Click Back to close the Settings window.
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Probe mic

Custom earmold

To 3A
insert earphone

Figure 6.2.4.2—RECD real-ear measurement setup 

6.2.5 Performing the REDD measurement
The REDD gives you a custom HL to SPL transform. You use your FONIX ana-
lyzer to measure the SPL output of the HL input of your FONIX audiometer. 
Take this measurement in the Audiometry window.

You must have both a FONIX hearing aid analyzer and a FONIX audiometer 
connected to your computer at the same time to perform this measurement 
automatically.

1.	 Put the earhook on the client’s ear and attach the probe microphone.

2.	 Insert the probe tube into the client’s ear.

3.	 Put the TDH earphones onto the client’s head or insert the insert ear-
phones. (Use the transducer you used to take the audiometric measure-
ments.) See Figure 6.2.5A.

4.	 If you are using a 6500-CX, do the following.  Otherwise, skip to step 5.

a.	Enter Probe mode by pressing [PROBE] on the main module.

b.	Press [START/STOP] to start the composite source.

c.	Press [∧] repeatedly until the source is completely turned off.

5.	 Select Measured in the REDD box in the Audiometry window.

6.	 Click Get REDD in the Audiometry window. This will open the REDD 
measurement window. See Figure 6.2.5B.

7.	 Click Start Test to start the pure-tone sweep measurement.
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8.	 Click Save Test to store the test results.

9.	 Click Back to return to the Audiometry window.

Figure 6.2.5A— Setup for the REDD measurement. The TDH earphone is placed on top of the 
probe mic setup.

Figure 6.2.5B— The REDD measurement window – use old figure

6.3 DSL Verification
There are two ways to verify that the hearing aid meets the DSL prescription: 
through coupler measurements and through real-ear measurements. In the DSL 
window, you can view the coupler and real-ear targets in dB GAIN or dB SPL. 
When displaying in dB SPL, you can also view the patient’s thresholds, upper 
limits, and the LTASS. Coupler and real-ear measurements can be performed 
and compared to the displayed targets. See Figure 6.3.
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Many of the steps to set up WinCHAP for a DSL verification measurement are 
the same for both coupler and real-ear measurements. These steps are described 
in Section 6.3.1. The actual measurement process is described in Section 6.3.2.

 

Figure 6.3—DSL Measurement window

6.3.1 Setting up
1.	 Click Settings and choose the General tab.

2.	 Select the Hearing Aid Style, Transducer, Loud Speaker Orientation, and 
Compression Threshold.

3.	 Choose the DSL Settings tab.

4.	 Select the appropriate Circuit Type. Choose between Linear, WDRC 
Fixed, and WDRC Variable.

5.	 Select the desired HL to SPL Transform. This affects how the threshold 
values are converted into SPL.

6.	 Select whether you want to use a Measured or Average RE to 2cc 
Transform in creating the coupler targets. If you choose Measured, you 
will have to perform the RECD measurement in the Audiometry window. 
See Section 6.2.4.

7.	 Select whether to use a Predicted or Measured Maximum Output. In gen-
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eral, if you entered measured upper limit values, select Measured here. 
Otherwise, select Predicted.

8.	 Click Back to close the Settings window. If you haven’t already, click DSL 
in the left column of the window to enter the DSL Verification window. 
See Figure 6.3.

9.	 Set up the analyzer for a real-ear or a coupler measurement. Make sure 
that the sound chamber or the sound field speaker is leveled.

6.3.2 Performing the measurements
1.	 Select whether you are performing Coupler measurement or a Real-ear 

measurement.

2.	 Select whether you want to want to display measurement results and tar-
gets in dB Gain or dB SPL by filling in the appropriate radio button.

3.	 Display the target to which you are measuring by selecting it in the tar-
get column. If the display is set to SPL, you can also display Thresholds, 
Upper Limits, and the LTASS.

4.	 Select the curve you are going to measure. A checkmark is displayed next 
to the current selected measurement curve.

5.	 Select the Source Type for the curve. Choose between Pure-tone, 
Composite, DS ANSI (Digital Speech ANSI), and DS ICRA (Digital Speech 
ICRA). The target will automatically adjust to fit the selected source type.

6.	 Select the SRC (source) of the curve. Choose between 40 and 100 in 5 dB 
increments. (95-100 dB SPL is only available for coupler pure-tone mea-
surements.)

7.	 Click Start to start the measurement. If performing a real-time measure-
ment, click Stop to stop the measurement after it has stabilized.

8.	 Repeat steps 3-7 to take any other desired measurements. WDRC aids are 
usually measured at 50, 65, 80, and 90 dB SPL. Linear aids are generally 
only measured at 65 and 90 dB SPL. See Figure 6.3.2.

9.	 Click Save in the toolbar to save the measurement.

10.	Click View Curve Data underneath the measurement graph to display the 
numerical results.
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Figure 6.3.2—DSL window including measured curves

When using WinCHAP to do a research project, it is often useful to be able to 
cut and paste the measurement data into a spreadsheet such as Excel. This can 
be done in WinCHAP by right clicking on the measurement data. Choose Copy 
All to copy all the displayed measurement data to your computer’s clipboard. 
You can then go to your spreadsheet project and use CTRL+V to paste the data 
there.

If desired, you can also copy a limited amount of data. Click and hold down 
the left button of your mouse and use it to select the data you want to copy. 
Unfortunately this data is not visibly highlighted. Then use your right mouse 
button and select Copy Selection. This will copy only the selected data to the 
clipboard. 

6.3.3  Testing with Live Speech
The Spectrum Analysis mode, available when your analyzer has the Composite 
signal, lets you use the external signal of your choice with your real-ear mea-
surements. You can use sounds from a CD player, the patient’s own voice, or the 
voice of a spouse or family member. Using the SPL display in the DSL window, 
you can display the reponse to the live speech signal and compare it to the 
patient’s threshold values, uncomfortable levels, and the LTASS speech banana.
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To do this, just follow the instructions for testing as described in Section 6.3.2. 
In step 5, select the Source Type to Composite. In step 6, set the Src. amplitude 
to 0 (Spectrum Mode). Press Start to start the measurement. Now use the live 
speech signal as the input source and see how the aid responds to it. Use the 
noise reduction setting on the analyzer to control how much long-term averag-
ing the analyzer uses when displaying the measurements. When noise reduction 
is set to OFF on the analyzer, the display will update very quickly in response to 
all the changes in speech. When the noise reduction is set to 16X, the response 
curve will update very gradually, showing the aid’s long-term response to the 
speech signal. See your analyzer’s Operator’s Manual for details on setting the 
noise reduction setting.

6.3.4 Adding the LTASS
The LTASS is a set of three curves based on the long-term, average speech 
spectrum. The middle curve is the average, the upper curve is the average plus 
12 dB and the lower is the average minus 18 dB. The LTASS curves show the 
boundaries of average speech, and can be used as a counseling tool to show a 
client how their hearing range relates to average speech sounds. It can be dis-
played in the DSL window in an SPL display.

6.3.5 Matching measurements with targets
DSL targets are dependent upon signal type and signal level. When adjustments 
are made to the signal, the DSL target makes corresponding adjustments. 

Each measurement is tied to a particular target; it is important to compare 
appropriate targets to each measurement. Only measurements tied to the select-
ed targets will be displayed. That is, if you have taken a measurement at 65 dB 
SPL, and then you change the target to 70 dB SPL, the 65 dB measurement will 
be removed from the window but not deleted. You can redisplay the 65 dB mea-
surement by changing the target back to 65 dB.

6.3.6 Understanding Speech Weighting
The DSL method was designed around the LTASS speech weighting. However, 
FONIX equipment normally uses the ANSI speech weighting, which rolls off the 
high frequencies more gradually. When working in dB Gain, the speech weight-
ing differences have little effect because the speech-weighted input signal is 
subtracted out to arrive at the gain values. However, when viewing targets and 
measurements in dB SPL, the speech weighting is not subtracted out and has a 
large impact on the displayed target.

In order for the FONIX measurements to be directly compared to the DSL tar-
gets, WinCHAP has altered the DSL targets to incorporate the FONIX speech 
weighting. If you would like to view the targets in their non-altered state, 
change the Signal Filter selection in the Settings window under the DSL tab. 
You will not be able to take a measurement when this speech weighting is 
selected.
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6.3.7 Measuring with Pure-tones
The FONIX FP35, 7000, and FP40 analyzers are equipped with several differ-
ent types of pure-tone measurements. The “Normal” pure-tone sweep performs 
a standard sweep once and automatically stops. The “Fast” sweep measures 16 
different frequencies repeatedly until the user stops the test. The “Short” sweep 
measures 10 different frequencies once and automatically stops.

WinCHAP automatically specifies the Short signal when performing real-ear 
measurements at 90 dB SPL. This means that only one quick sweep will be run 
before the test automatically terminates.

You can choose whether you want to use a Normal or a Fast sweep when per-
forming pure-tone measurements below 90 dB SPL by changing the PT Signal 
Mode in the Settings window. 

Notes:

•	 The 6500-CX does not have the Fast or Short selections available. Real-ear 
pure-tone measurements are performed using only frequencies specified by 
NAL and DSL. Coupler measurements are performed with a Normal pure-tone 
sweep.

•	 The FP40 is not very responsive to computer commands during a Fast sweep 
when the reference microphone is on. During those conditions, WinCHAP 
will only perform only one sweep before terminating the test.

6.4 NAL-NL1 Verification
The NAL-NL1 window is used to fit a hearing aid to the NAL-NL1 fitting for-
mula. You can choose to perform the fitting with insertion gain or gain targets; 
any measurement taken in one scaling is automatically converted for use with 
the other scaling. The SSPL90 selection is used for testing output at loud levels. 
See Figure 6.4.
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Figure 6.4: NAL-NL1 measurement window

6.4.1 Setting up
The procedure for setting up for an NAL-NL1 fitting is very similar to that for a 
DSL fitting. 

1.	 Click Settings and choose the General tab.

2.	 Select the desired HA type: BTE, ITE, CIC, or ITC. 

3.	 Set the Transducer and Loud Speaker Orientation if you haven’t already 
done so.

4.	 Select the Compression Threshold level of the hearing aid if you are fit-
ting a WDRC aid. 

5.	 Choose the NAL-NL1 Settings tab.

6.	 Select the appropriate Reference Position. If you use the recommended 
leveling procedure performed with the patient in the sound field, this 
should be set to Head Surface. If you level with the patient outside of the 
sound field (not recommended), set this to Undisturbed Field.

7.	 Select aid’s Output Limiting. Choose between Multi-Channel, Wideband, 
or Off. (The Off selection will not give you an SSPL target.)
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8.	 Select the Fitting Type. If Bilateral is selected, make sure that the 
audiometric data for both ears is entered in the Audiometry window.

9.	 Set the Channels, Measured RECD coupler, Tubing, and Venting selec-
tions. 

10.	Click Back to close the Settings window. If you haven’t already, click 
NAL in the left column of the window to enter the NAL-NL1 window. See 
Figure 6.4.

13.	Set up the analyzer for a real-ear or a coupler measurement. Make sure 
that the sound chamber or the sound field speaker is leveled.

6.4.2 Performing the measurements
1.	 Select whether you are performing a Coupler measurement or a Real-ear 

measurement.

2.	 Select whether you want to want to display measurement results and tar-
gets in dB Gain or dB Insertion Gain. The SSPL selection is used for mea-
suring the saturation response of the aid.

3.	 Display the target to which you are measuring by selecting it in the target 
column.

4.	 Select the curve you are going to measure. A checkmark indicates the cur-
rent selected curve.

5.	 Select the Source Type for the curve. Choose between Pure-tone, 
Composite, DS ANSI (Digital Speech ANSI), and DS ICRA (Digital Speech 
ICRA). The target will automatically adjust to fit the selected source type. 
See Section 6.3.7 for details on pure-tone measurements.

6.	 Select the amplitude SRC (source) of the curve. Choose between 40 and 
100 in 5 dB increments. (95-100 dB SPL is only available for coupler 
pure-tone measurements.)

7.	 Click Start to start the measurement. If using a real-time signal, wait for 
the measurement to stabilize and click Stop to stop it.

8.	 Repeat steps 3-7 to take any other desired measurements. WDRC aids are 
usually measured at 50, 65, 80, and 90 dB SPL. Linear aids are generally 
only measured at 65 and 90 dB SPL. See Figure 6.4.2.

9.	 Click Save in the toolbar to save the measurement.

10.	Click View Curve Data underneath the measurement graph to display the 
numerical results.
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Figure 6.4.2—NAL window with measurements

When using WinCHAP to do a research project, it is often useful to be able to 
cut and paste the measurement data into a spreadsheet such as Excel. This can 
be done in WinCHAP by right clicking on the measurement data. Choose Copy 
All to copy all the displayed measurement data to your computer’s clipboard. 
You can then go to your spreadsheet project and use CTRL+V to paste the data 
there.

If desired, you can also copy a limited amount of data. Click and hold down 
the left button of your mouse and use it to select the data you want to copy. 
Unfortunately this data is not visibly highlighted. Then use your right mouse 
button and select Copy Selection. This will copy only the selected data to the 
clipboard. 

6.4.3 Checking Curve Parameters
The NAL-NL1 Parameter window is displayed by clicking View Parameter 
Table. See Figure 6.4.3. The Parameter window displays the compression ratio, 
crossover frequency, and the recommended gain values for the displayed param-
eters. Instead of showing an entire gain curve, the Parameters window just 
shows the targets for the selected frequencies. The number of target values dis-
played matches the number of channels selected in the Settings menu.
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You can change:

•	 Output Conditions: Speech levels are used when testing with a broadband 
signal such as Composite or Digital Speech. Pure tone should be selected 
when measuring with a flat weighted pure-tone signal.

•	 Scaling: Select the type of target value you want to display. REIG shows 
real-ear insertion gain target values, REAG displays real-ear aided gain, 2-cc 
coupler shows coupler target values, and Ear Simulator displays simulated 
real-ear target values.

•	 Test Frequency: Choose the frequency for which the target is displayed.

•	 Amplitude: Select the input amplitude for the displayed target.

Click Back to NAL Curves to return to the NAL graphical display.

 

Figure 6.4.3—Curve parameters window display
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6.5 Info
The Info window (Figure 6.5) is used to identify the Operator, Analyzer, and 
Audiometer used to perform the hearing aid fitting. It also contains the DSL 
prescriptions for the amplification that a hearing aid should produce in order to 
be a good fit for your client. These values can be compared to the hearing aid’s 
published manufacturer specifications.

The coupler values displayed in this window are:

•	 SSPL: Target maximum output SPL. 

•	 Full-on Gain: A reserve gain ranging from 1 dB to 20 dB (in 1 dB steps) is 
used to calculate this target value.

•	 User Gain: For linear aids, the user gain is tied to the speech spectrum 
selected in the DSL tab of the Settings window. It is the output of that speech 
spectrum minus its input. For WDRC aids, the user gain is tied to the input 
level selected on the Info window. It is the coupler target output at that level 
minus its input.

Figure 6.5—The Info window
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6.6 Reference
This section describes all of the different settings available in the Settings window.

6.6.1 Understanding General Settings 
•	 Hearing Aid Style: Select the hearing aid style affects the natural resonance 

of the ear, and so compensations are made for style when calculating the cou-
pler prescription curves. Choose from BTE, CIC, ITC, ITE, and Body.

•	 Transducer: This selection specifies the transducer used in making the 
audiometric measurements. It affects the HL to SPL transform, the targets, 
and some of the other settings. See Table 6.6.1 for a listing of allowed set-
ting combinations. The RECD and HL to SPL settings referred to by the table 
are located in the DSL settings tab. A selection of “Insert Custom Mold” will 
require a measured RECD in order to generate coupler targets in the DSL win-
dow.

•	 Loud Speaker Orientation: This selection specifies the position of the loud 
speaker used to obtain audiometric and real-ear sound field measurements. 
We recommend using a 45 degree angle for most repeatable results.

•	 Show HL to SPL Transform in: This selection chooses whether to display the 
SPL values in the tables of the Audiometry window as coupler SPL or real-ear 
SPL.

•	 Compression Threshold: Choose from 40 dB to 65 dB. Your choice should 
match the compression threshold of the hearing aid.

•	 Show Curve Symbols: Turn on or off the display of the numbers and symbols 
identifying the displayed curves.

•	 Show Graph Lines: Turn on and off the display of the graph lines in the vari-
ous windows.

•	 Share DSL w/NAL Meas: Choose whether or not to make tests taken in the 
DSL window be available in the NAL window.

•	 Share NAL w/DSL Meas: Choose whether or not to make tests taken in the 
NAL window be available in the DSL window.

•	 Apply Corrections: Choose whether or not to correct the NAL and DSL dB 
SPL targets to take into consideration the FONIX speech weighting. It is rec-
ommended to select Yes.

•	 PT Signal Mode: Select the type of signal used with pure-tone measurements. 
The Fast selection does a quick, repeating pure-tone sweep that doesn’t stop 
until you tell it to stop. The Normal selection does one full pure-tone sweep.
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•	 Show Aud. Predicted In DSL or NAL-NL1: This selection specifies which 
type of predicted transform is displayed in the tables of the Audiometry win-
dow. This will have no affect on any actual measurements or target values in 
the measurement windows.

•	 Audiometric Symbols: Type of audiometric symbol displayed on the graphs. 
Choose between USA and UK.

•	 Refresh on click/Refresh only when requested: This will select whether the 
DSL window is refreshed every time you click your mouse and make a selec-
tion, or whether it will be refreshed only when you click the Refresh button. 
For better speed performance, choose Refresh only when requested. For more 
window updates, choose Refresh on click.

Table 6.6.1 
	 List of allowable setting combinations	

	 Transducer	 HL to SPL	 RECD	 Aid Style	
	 ER3 Insert Earphone	 Predicted	 Predicted	 Any 
		  RECD	 Measured
		  REDD

	 TDH headphones	 Predicted	 Predicted	 Any 
		  REDD	 Measured

	 Loudspeaker 0, 45, 90	 Predicted	 Predicted	 Any 
		  REUR	 Measured	

	 Insert Custom Mold	 RECD	 Measured	 BTE

	 SPL Transform	 Predicted	 Measured	 Any

6.6.2 Understanding NAL-NL1 Settings
•	 Reference Position: Select Head Surface when sound field leveling is per-

formed with the reference microphone placed on an earhook on the patient’s 
ear. Select Undisturbed Field when leveling is performed without the patient 
in the sound field. Head Surface leveling is preferred for all FONIX real-ear 
measurements.

•	 Limiting: Select the aid’s type of output limiting. Choose between Wideband 
and Multi Channel. No SSPL90 targets will be created when this selection is 
set to Off. 

•	 Fitting Type: Select between Unilateral and Bilateral. If Bilateral is selected, 
make sure to input audiometric data from the left and the right ear. This will 
affect the measurement targets.
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•	 Apply HL Corrections: Choose whether to apply NAL age-correcting HL val-
ues. It is recommended to select Yes for this setting.

•	 Channels: Select the number of channels that the aid has.

•	 Measured RECD: Select whether the RECD measurement was made with an 
HA-1 coupler or with an HA-2 coupler. This is only used when an RECD is 
measured.

•	 Tubing: Select the tubing used in a BTE fitting. This is used when creating 
coupler targets.

•	 Venting: Select the venting used in the earmold or the body of the aid. This is 
used when creating coupler targets.

6.6.3 Understanding DSL Settings
•	 Circuit Type: Select whether the aid is linear, WDRC-fixed, or WDRC-vari-

able.

•	 HL to SPL Transform: Select the transform to use when converting data from 
dB HL to dB SPL. This affects the targets and the display of the audiometric 
data in the SPL displays.

°	 Predicted: Uses the client age and selected transducer to predict the HL to 
SPL transform. Note: there are no age correction factors for the TDH head-
phones transducer type.

°	 RECD: Only available when a Transducer Type of ER3 Insert Earphone or 
Insert Custom Mold is used.

°	 REUR: Only available when the Loudspeaker Transducer Type is select-
ed. It is assumed that the loudspeaker azimuth used for measurement of 
the REUR is the same as the azimuth used for audiometric testing. You 
must enter REUR values manually.

°	 REDD: When taking this measurement, use the transducer used for mea-
suring the audiometric values.

•	 RE to 2cc Transform: Choose whether to use an Average or Measured RECD 
when creating coupler targets.

•	 Maximum Output: Choose whether the maximum output value uses the 
Measured or Predicted upper limit values. The maximum output is not dis-
played, but it is used in the calculation of some values.

•	 Loudness Function: Factors the exponent values into compression targets. 
DSL defines the exponent values as the “ratio of a normal hearing loudness 
exponent to the hearing-impaired individual’s loudness exponent.” Only 
available with WDRC-Variable circuit type. It is recommended to have a selec-
tion of Predicted for this field.
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•	 Signal Filter: Select the speech weighting used to create the targets. A selec-
tion of FONIX is necessary for making measurements. The DSL selection 
uses UWO Child for children and Cox & Moore for adults. DSL and FLAT are 
intended for informational purposes only; you can’t use them to make mea-
surements with FONIX analyzers. 
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Hearing Aid Measurements
7.1  Introduction

WinCHAP can gather data from nearly all of the tests available on the FONIX 
FP40, 6500-CX, 7000, and FP35 hearing aid analyzers.

The following tests and test sequences are available:

•	 Response curves & Real Ear

•	 ANSI S3.22-1987 

•	 ANSI S3.42-1992

•	 ANSI S3.22-1996

•	 ANSI S3.22-2003

•	 IEC

•	 JIS

•	 Coupler Directional

Most hearing aid analyzers are not equipped to run all of these measurement 
curves; we included all of them to make WinCHAP more universally friendly. 
You will, however, only be able to run those automated test sequences sup-
ported by your analyzer. If you try to run an automated test sequence that your 
analyzer doesn’t support, WinCHAP will give you an error message.

In the ANSI S3.22 test screens, the user can adjust most test settings. That 
is, you can set the aid type, turn on and off the battery and telecoil tests, and 
adjust other settings such as the three frequency average. The JIS, ANSI S3.42, 
IEC, JIS, Response Curves, and Real-ear test screens do not have this functional-
ity. The main use of these test screens in WinCHAP is to collect measurement 
data that has already been performed, although you can also start measurements 
using the current settings on the analyzer.

For the purposes of this manual, the hearing aid tests supported by WinCHAP 
have been grouped into four different categories: individual curve tests 
(Response Curves and Real-ear), ANSI S3.22 tests, (ANSI 87, ANSI 96, 
ANSI 03), other automated test sequences (IEC, ANSI 92, JIS), and Coupler 
Directional.

7.2 General Test Information
Every test window in WinCHAP share some similarities and common interfaces. 
The functions listed in this section apply to all measurement windows. For 
more information on the Response Curves window, see Section 7.3. For more 
information the Real-Ear window, see Section 7.4. For more information on the 
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ANSI S3.22 test sequences, see Section 7.5. For more information on any of the 
other automated test sequence windows (IEC, JIS, ANSI 92) see Section 7.6. For 
more information on the Cuupler Directional test for the FONIX 8000 Hearing 
Aid Test System, see Section 7.7.

Each test window has the following features:

•	 You can check the connection of your analyzer.

•	 The main window of the display contains graphical representations of the 
test results.

•	 There is a button or tab containing the numerical data of the test results.

•	 All of the test parameters in either a button, tab, or on the test screen 
itself.

•	 There are basic analyzer controls that can be performed remotely from 
within WinCHAP.

7.2.1 Creating & Opening Tests
All hearing aid tests are attached to a particular hearing aid. These are the steps 
you must take to save a hearing aid test in WinCHAP:

1.	 Create the hearing aid record in the Office Manager or in the Quick Entry 
Hearing Aid window. See Sections 3.2.2.1, 3.3.2.1, and 3.3.2.2. 

2.	 Open the hearing aid record in the Test Menu. See Section 4.1.3.

3.	 Create a new hearing aid test and choose the type of test you would like 
to take. See Section 4.2.2.

4.	 Get the test from the analyzer. See Section 7.3 for information on using 
the Response Curves window, Section 7.4 for information on using the 
Real-Ear window, and Section 7.5 for information on using the automated 
test sequence windows such as ANSI 87, ANSI 96, and IEC.

5.	 Save the test by clicking Save in the toolbar of the measurement window.

6.	 Close the window by clicking Back.

7.	 The new test will be listed under the hearing aid in the Test Menu. You 
can open it again by double-clicking it.

7.2.2 Checking the analyzer’s connection
Before you can get any measurement curves from your FONIX analyzer, your 
computer must be connected to your hearing aid analyzer. See Section 1.3 and 
Section 2.2.2 for instructions on setting up the connection.

Use the Check button in the toolbar of the measurement window to check your 
analyzer’s connection. If you are unable to establish a connection, try click-
ing the Check button again, making sure the analyzer is powered up and that 
the connections between the analyzer and the computer are solid. You can also 
check your COM port configuration.
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To change the COM port used for the analyzer connection:

1.	 Open the Tools menu from the test window and select FONIX 
Communication Setup. This will open the Communications Setup win-
dow.

2.	 Select the COM port used by your FONIX analyzer in the appropriate 
drop-down list.

3. 	 Click the Check Analyzer button to verify your connection.

4.	 Click Save Settings.

5.	 Click Back to close the Communications Setup window.

7.2.3  Viewing the graph
Each WinCHAP test window contains a graphical display of the test results. See 
Figure 7.2.3 for an example of the Response Curve window. 

Figure 7.2.3—The graphical display of the Response Curves window

Each curve on each graph is labeled with a number. A legend to the right of the 
graph identifies the curves. By default, this legend includes the source type and 
level used when taking the measurements, but, in the Response Curves and Real 
Ear tests, this label can be changed to whatever the user wants it to be.
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There are several things you can do to alter the graphical display:

•	 To turn off the display of a particular curve, click the box next to its list-
ing in the graph legend, and remove its “x.” This will temporarily clear 
the curve from the graph. To redisplay the graph, just select it again.

•	 To center the graph on a particular curve, right click on the curve’s listing 
in the graph legend.

•	 To remove the identifying numbers from the curves on the graph, click 
the box labeled “Show curve numbers” in the lower left corner of the 
window, and deselect it.

•	 To change the curve colors, open the View menu and select Color Palette.
This will open a window that will let you change the color of each curve.

7.2.4 Viewing numerical data
Each graph has corresponding numerical data. In the Response Curves and Real-
Ear window, you get to this window by clicking the Test Curves tab. In an auto-
mated test sequence window, you get to this data by clicking the Data button or 
tab.

A listing containing the amplitude and frequency of each graph (the x and y val-
ues) is displayed in the data window. See Figure 7.2.4 for an example of the data 
display in the Response Curve window.

Figure 7.2.4—Data display in the Response Curves window
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When using WinCHAP to do a research project, it is often useful to be able to 
cut and paste the measurement data into a spreadsheet such as Excel. This can 
be done in WinCHAP by right clicking on the measurement data. Choose Copy 
All to copy all the displayed measurement data to your computer’s clipboard. 
You can then go to your spreadsheet project and use CTRL+V to paste the data 
there.

If desired, you can also copy a limited amount of data. Click and hold down 
the left button of your mouse and use it to select the data you want to copy. 
Unfortunately, this data is not visibly highlighted, but it is invisibly selected 
(we will add the highlighting in a future software revision of WinCHAP). Then 
use your right mouse button and select Copy Selection. This will copy only the 
selected data to the clipboard. 

The Response Curves and Real-Ear windows also display a second data list-
ing containing any harmonic distortion measurements taken when measuring 
the curves. The automated test sequence windows may also contain data from 
input/output measurements.

7.2.5  Understanding the curve parameters
Every graphical test display has a corresponding window showing the param-
eters used when taking each response curve measurement. In an automated test 
sequence, you get to this display by clicking the Data button and choosing the 
Curve Parameters tab. In the Response Curves and Real-Ear windows, you get 
to this display by choosing the Curve Parameters tab in the main window. See 
Figure 7.2.5 for the curve parameters display of the Response Curves window.

There are 22 curve parameters. Here is a short explanation of each parameter:

•	 Crv. Signal Type—The type of signal used to perform the test (for exam-
ple, composite)

•	 Distortion Status—Notes the type of distortion measured (for example, 
total harmonic distortion)

•	 Insitu Correction—Notes whether or not an insitu correction has been 
used.

•	 Reference Mic—Records whether the reference mic is on or off.

•	 Smoothing—Notes whether or not smoothing was used.

•	 Environment—The place the test took place (for example, sound cham-
ber).

•	 Applied Filtering—Notes the use of filtering in the measurement.

•	 Leveling Status—Records the degree of leveling achieved for the test.

•	 Curve Values—The type of values used (for example, gain or SPL).

•	 OES Correction—Notes whether or not an MZ coupler and corrections 
were used.
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•	 Ear Used—Records the ear tested.

•	 Crv. Modification—Notes whether or not the curve has been modified.

•	 Data Points—The number of data points measured for the curve.

•	  Correction—Notes whether or not a CIC coupler and corrections were 
used.

•	 Curve Type—Records the type of measurement made (for example, 
REUR).

•	 Curve Subtype—Further categorizes the curve.

•	 Source Amp.—Notes the level of the input used to make the measure-
ment.

•	 Highest Value—Notes the maximum value of the curve.

•	 Overall RMS—Records the overall amplitude of the curve.

•	 Noise Reduction—The amount of noise reduction used for the test.

•	 Bias Source—The intensity of the bias signal, if a bias signal is used.

•	 Bias Freq.—The frequency of the bias signal, if a bias signal is used.

To view the parameters of a particular curve, select the curve in the box labeled 
Test Curves and click Show Parameters.

Figure 7.2.5—Curve parameters in the Response Curves window
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7.2.6 Controlling your analyzer
There are some very basic analyzer controls that you can perform remotely from 
your computer with WinCHAP. To reach them, open the Tools menu of the test 
window and point at Analyzer Tools. You will see the following selections:

•	 Reset analyzer: This is equivalent to pushing the “Reset” button on your 
analyzer.

•	 Level analyzer: This is equivalent to pushing the “Level” button on your 
analyzer. It will attempt to level the test environment.

•	 Print with analyzer: This will cause the analyzer to dump the current 
analyzer window to its built-in internal printer or attached external print-
er.

•	 Line feed with analyzer: This will advance the paper in the analyzer’s 
internal thermal printer.

•	 Set analyzer label: This will bring up a window that will let you set the 
label printed with the thermal paper test strip. See Section 7.2.7.

7.2.7 Changing your analyzer’s label
You can use WinCHAP to change the label printed with the analyzer’s internal 
thermal printer or attached external printer.

1.	 Open a WinCHAP test window. See Section 4.2.2 for details.

2.	 Open the Tools menu, point at Analyzer Tools, and select Set Analyzer 
Label. This will open the Analyzer Label Setting window. See Figure 
7.2.7.

3.	 Type your desired label into the provided lines.

4.	 Click Set. This will set the displayed label as your analyzer’s new default 
label. This label will be saved even if you turn off your analyzer.

Figure 7.2.7—Analyzer Label Settings window
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There are a couple of other functions you can perform in this window:

•	 Click Restore to restore the analyzer’s label to factory settings.

•	 Open the File menu and select Save Label Settings to save the current 
window to WinCHAP. This will make it so that the current label settings 
come up the next time you open the Analyzer Label Settings window.

•	 Click Back to close the Analyzer Label Settings window.

7.3  The Response Curves Test Window
The Response Curves test window lets you display and save up to 12 response 
curves. See Figure 7.2.4.

Each curve on the graph is labeled with a number. A legend to the right of the 
graph identifies each curve with a label that includes, by default, the source 
type and amplitude used when taking the measurement. This label can be modi-
fied. See Section 7.3.7.

7.3.1 Opening a Response Curves Test window
The Response Curves test records are always saved to a hearing aid record. For 
this reason, the hearing aid record must be created inside WinCHAP before 
opening a Response Curves test window.

1.	 Create a record for the hearing aid. See Section 3.2.2.1 or Section 3.3.2.2.

2.	 Enter the Test Menu by clicking on the Test Menu button in the Main 
Menu.

3.	 Open the hearing aid record in the test menu. You can do this one of two 
ways:

•	 Search for the client record (This only works if the hearing aid is 
attached to a client record.) When located, click the PLUS (+) to the 
left of the client listing to display any hearing aids attached to that 
client.

•	 Search for the hearing aid record. If the hearing aid has any saved 
tests saved to it, a PLUS (+) will be visible to the left of the hearing 
aid listing in the right column of the Test Menu. Click the PLUS (+) 
to expand the folder and display the saved tests.

	 See Section 4.1.3 for details on searching for a record.

4.	 Double-click on the saved test to open it, or double-click on the hearing 
aid listing in the right column to open the hearing aid test select window, 
and choose Response Curves. 
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7.3.2 Using the Connect button
The Connect button in the toolbar of the Response Curves and Real-Ear tests 
creates a real-time connection between your computer and your analyzer. 
Any current running measurement on your analyzer will be displayed on the 
WinCHAP display.

1.	 Set up the analyzer and hearing aid for coupler testing.

2.	 Start the real-time measurement on your analyzer using a FAST pure-tone 
sweep, Composite signal, or Digital Speech signal.

3.	 Click Connect in the Response Curves test window to establish a real-
time connection. To speed up the connection, the grid lines on the 
WinCHAP display will temporarily disappear.

4.	 When satisfied, click Disconnect to end the connection.

5.	 Click Save to save the measurement.

7.3.3 Getting curves from your analyzer
If you have taken a coupler response curve or set of response curves on your 
FONIX analyzer, you can transfer those measurements to WinCHAP by using 
the Get Curves button in the Response Curves toolbar.

6500-CX: If you are in the Composite measurement screen, Get Curves will grab 
the curve displayed on the screen. If you are in the 6500-CX Multi-curve screen, 
Get Curves will grab any curves stored in CRV 1-4.

If you would like to grab only specific curves, or if you would like to grab refer-
ence curves:

1.	 Open the Tools menu.

2.	 Select 6500-CX Multicurve.

3.	 Select which curves you would like to grab.

4.	 Click Save.

5.	 Click Back to close the window.

6.	 Click Get Curves. This will get the curves selected in step 3.

FP35/7000/8000: Get Curves will grab any curves shown in the Coupler Multi-
curve screen.

FP40: If Multi-curve is OFF on the FP40, Get Curves will grab the curve dis-
played in the coupler screen. If Multi-curve is ON, Get Curves will grab any 
curves stored in CRV 1-4.
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7.3.4 Sending curves to your analyzer
You can send any curve displayed in the Response Curves window to your ana-
lyzer using the Send Curves button.

1.	 Choose the curves you want to send to your analyzer by having them dis-
played on the window. You can send up to four curves. If you have more 
than four curves displayed, only the first four will be sent.

2.	 Click Send Curves. This will open the Send Curves window. See Figure 
7.3.4.

Figure 7.3.4—The Send Curves window

3.	 Select Multi-Curve Coupler.

4.	 Click Go to send the curves. A window will open, confirming that the 
curves have been sent.

5.	 Click Back to close the Send Curves window.

7.3.5 Adding saved curves
It can often be useful to compare curves you have previously saved to the 
currently displayed curves. For example, you can compare the response of a 
hearing aid to the response it had at a previous date. Or, you can compare the 
response of the left hearing aid to the saved response of the right hearing aid of 
a binaural set of aids.

1.	 Click Add Curves in the Response Curves window. This will open the 
Add Curves window. See Figure 7.3.5. 

2.	 Look at the list of displayed hearing aids. If the aid is attached to a client, 
all aids attached to that client will also be displayed. Any aids with saved 
measurements will have a PLUS (+) to the left of the aid listing.

3.	 Click the PLUS (+) to the left of the hearing aid listing to display the 
saved tests of the hearing aid. Each test will have a PLUS (+) next to it, 
indicating that there are individual measurements saved to it.



WinCHAP User’s Manual	 Hearing Aid Measurements   97

4.	 Click the PLUS (+) symbol to the left of test listing to display the individual 
measurements saved to that test.

5.	 Select the individual measurement you would like to add and click Add 
Selected Curve. It will appear in the Selected Curves Basket.

6.	 Repeat Steps 3-5 to add any other desired measurements.

7.	 Click Load Selected Curves to add those curves to the Response Curves win-
dow.

8.	 Click Back to close the Add Curves window. The new curves will now be 
displayed on the graph.

Figure 7.3.5—The Add Curves window

Other functions in the Add Curves window:

•	 Remove Selected Curve will remove the selected curve from the Selected 
Curves Basket; it will no longer be loaded into the Response Curves window.

•	  will remove all curves from the Selected Curves Basket.

•	  will search for a hearing aid to display on the window.

•	  will list all hearing aids in the database, or all measurements in the 
database, sorted by test type.

•	  are used when a large quantity of hearing aids or records are dis-
played. Use the arrows to skip to the next group of records.
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7.3.6 Deleting curves
The Delete Curves button is used to permanently delete curves from the 
Response Curves window.

1.	 Display the curves you would like to delete. If there is a curve on the 
graph that you do not want to delete, click the box next to its listing and 
temporarily turn off its display.

2.	 Click Delete Curves. This will delete all curves displayed on the graph. 
Any curves not deleted will automatically be displayed.

3.	 Click Save to save your changes.

7.3.7  Changing the curve labels
Each measurement curve displayed in WinCHAP has a corresponding label that 
is used to identify the curve. By factory default, the curve label automatically 
used for each curve contains its source type, source amplitude, and the scaling 
used for the measurement. If desired, however, you can change this curve label 
to be whatever you want it to be. You can create custom labels that will be used 
by default for all tests, and you can change the labels just for a specific test.

To create custom labels for multiple curves:

1.	 Open the View menu and select Custom Curve Labels. This will open the 
Set Curve Labels window.

2.	 Select Custom Labels at the bottom of the window under Curve Labels.

3.	 Enter the custom labels you want to use for Curves 1-12. 

4.	 Click Apply Changes. This will apply the custom labels to all the curves 
for this particular test.

5.	 Open the Tools menu and select Save Custom Labels as Default if you 
want to use these custom labels for all future tests. Otherwise these 
changes will only be used for the open test.

To create a custom label for an individual curve:

1.	 Right click on the curve label you want to change.

2.	 Select Change Label. This will open the Change Curve Label window.

3.	 Enter the new label into the provided box.

4.	 Click OK. This will close the window and change the label of the 
response curve.

Other functions in the Set Curve Labels window:

•	 The Auto Labels selection will automatically set the labels with the 
source type, source amplitude, and scaling used with the measurement.

•	 The Reset Labels button will reset the custom labels to the factory default 
settings of “Curve 1”, “Curve 2”, “Curve 3”, etc.
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7.4 The Real-Ear Test window
The Real-Ear test window, like the Response Curves test window, lets you dis-
play and save up to 12 real-ear measurements. See Figure 7.4.

Each curve on the graph is labeled with a number. A legend to the right of the 
graph identifies each curve including the curve type, source type, and source 
level used when taking the measurement.

Figure 7.4—Response Curves window

7.4.1 Using the Connect button
The Connect button in the toolbar of the Real-Ear window creates a real-time 
connection between your computer and your analyzer. The established connec-
tion depends on the type of analyzer.

6500-CX

The 6500-CX must be in Auto mode in the Insertion Gain screen and running 
an aided measurement. At this time, the 6500-CX cannot establish a real-time 
connection in the SPL Testing screen, or while the analyzer is in manual mode 
in the Insertion Gain screen.
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7000, FP40 & FP35

When the FP40 and FP35 analyzers are in their Insertion Gain screens, the 
CONNECT button will establish a real-time connection with the insertion gain 
curve. When they are in their SPL test screens, the CONNECT button will estab-
lish a real-time connection with the current REAR curve.

General instructions

1.	 Set up the analyzer and hearing aid for real-ear testing.

2.	 Start the real-time measurement on your analyzer using a FAST pure-tone 
sweep, composite signal, or digital speech signal.

3.	 Click Connect in the Real Ear Test window to establish a real-time con-
nection. To speed up the connection, the grid lines on the WinCHAP dis-
play will temporarily disappear.

4.	 When satisfied, click Disconnect to end the connection.

5.	 Click Save to save the measurement.

7.4.2 Getting curves from your analyzer
If you have taken real-ear measurements with your FONIX analyzer, you can get 
those measurements using the Get Curves button in the Real-Ear toolbar. The 
curves that are grabbed from the analyzer depend on the analyzer model, soft-
ware version, and the mode.

6500-CX

•	 In the Insertion Gain screen:

–	 REUR (real-ear unaided response)

–	 REAR (real-ear aided response)

–	 REIG (real-ear insertion gain)

–	 Insertion gain target

•	 In the SPL screen, set AUTO SAVE AIDED CURVES to YES in the Menu. 
(The 6500-CX must have software version 4.71 and above):

–	 SPL Aided 1

–	 SPL Aided 2

–	 SPL Aided 3

If you would like to grab only specific curves, or if you would like to grab refer-
ence curves:

1.	 Open the Tools menu.

2.	 Select 6500-CX Multicurve.

3.	 Select which curves you would like to grab.

4.	 Click Save.
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5.	 Click Back to close the window.

6.	 Click Get Curves. This will get the curves selected in step 3.

FP35 & FP40				    7000	 	

•	 In the Insertion Gain screen:	 •  In the Insertion Gain screen:	

–	 REUR				    – REUR 1		

–	 Insertion Gain Target		  – REAR 2-5

–	 Aided Curve 1			   – REIR 6-9

–	 Aided Curve 2			   – Target

–	 Aided Curve 3	

–	 Insertion Gain 1	 	 •  In the SPL screen:

–	 Insertion Gain 2			   – REUR 1

–	 Insertion Gain 3			   – REAR 2-5

–	 Target

•	 In the SPL screen (FP40 must have software version 3.50 and above):

–	 SPL Aided 1

–	 SPL Aided 2

–	 SPL Aided 3

7.4.3 Sending a target to your analyzer
Instead of manually generating a target on your analyzer, you can send the tar-
get to your analyzer from WinCHAP. 

See Section 5.5.1 for instructions on generating an insertion gain target from 
WinCHAP and sending it to the analyzer. See Section 5.5.2 for instructions on 
sending an audiogram to the analyzer.

7.4.4 Sending curves to your analyzer
You can send any curve displayed in the Real-Ear window to your analyzer 
using the Send Curves button.

1.	 Choose the curves you want to send to your analyzer by having them dis-
played on the window. You can send up to four curves. If you have more 
than four curves displayed, only the first four will be sent.

2.	 Click Send Curves. This will open a new window.

3.	 Select Probe.

4.	 Select the desired ear.

5.	 Click Go to send the curves. A window will open, confirming that the 
curves have been sent.

6.	 Click Back to close the Send Curves window.
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7.4.5 Adding Curves & Deleting Curves
The Real-Ear window has many similarities to the Response Curves window. 
Like the Response Curves window, you can add saved curves to the graph, you 
can delete curves from the graph, and you can create custom labels for the dis-
played curves.

To do these things, see the explanations in Section 7.3.5, Section 7.3.6, and 
Section 7.3.7, respectively.

7.5  ANSI S3.22 (ANSI 87/96/03)
There are three different versions of the ANSI S3.22 standard: ANSI 87, ANSI 
96, and ANSI 03. Figure 7.5 shows an example of the ANSI 03 automated test 
sequence screen. In the ANSI S3.22 test screens, you can adjust the test settings 
from WinCHAP, perform the automated test remotely, and grab previously per-
formed test results from the analyzer.

 
Figure 7.5—ANSI S3.22-2003 test results

7.5.1 Running an ANSI S3.22 Test
To remotely perform an ANSI test:

1.	 Create an ANSI test record. (See Section 4.2.2.)

2.	 Adjust the ANSI 87 (Section 7.5.2), ANSI 96 (Section 7.5.3), or ANSI 03 
(Section 7.5.4) test settings.

3.	 Make sure you have a good connection with your FONIX analyzer.
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4.	 Click Start Test. If any adjustments need to be made to the hearing aid 
during the test sequence, you will receive prompts with instructions. 
Follow the instructions and continue the test sequence.

5.	 Click the Save button to save the test results, if desired.

6.	 Click the Print button to print the test results, if desired.

Alternately, use the Get Test button to obtain test results already performed on 
the analyzer.

7.5.2  Adjusting the ANSI 87 Test Settings
The main ANSI 87 test settings are available in the test window.

•	 Aid Type:

-	 Adaptive AGC: For compression hearing aids that need a long time 
to adjust to the test signal before taking the measurement.

-	 AGC: For normal compression hearing aids.

-	 Linear 60: For most linear hearing aids

-	 Linear 50: For high gain linear hearing aids that may saturate at 60 
dB.

•	 Telecoil: Performs a telecoil measurement with the test sequence. The 
analyzer must support telecoil measurements.

•	 Battery: Performs a battery current measurement with the test sequence. 
The analyzer must support battery current measurements.

•	 Avg: The three frequency average used with the test sequence. This will 
almost always be the HFA 1000, 1600, 2500 frequencies.

Other settings are available in the Settings window that you open by clicking 
the Settings button.

•	 Operator: The clinician who performs the test. You can use the drop 
down menu or type in the clinician’s name. Any new names typed into 
the test screen will be automatically added to the WinCHAP database.

•	 Aid Type: This setting is identical to the setting in the test window.

•	 Noise Reduction: This performs a set number of measurements at each 
frequency in the test and averages the measurements together to deter-
mine the final test result. Choices are OFF (one measurement per frequen-
cy), 2X, 4X, 8X, 16X.

In the ANSI tab of the Settings window:

•	 OSPL90 and RESP colors: This allows you to change the colors used for 
the curves in the ANSI test.

•	 Telecoil: This setting is identical to the setting in the test window.

•	 Battery: This setting is identical to the setting in the test window.

•	 Avg: This setting is identical to the setting in the test window.
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Notes:

•	 Use the Save Settings button in the Settings window to save all the cur-
rent settings as defaults.

•	 Use the Restore Defaults button in the Settings window to restore all set-
tings to factory defaults.

•	 Use the Get Info button in the Settings window to automatically grab the 
analyzer type and serial number used to perform the test.

•	 The hearing aid information shown in the Settings window is automati-
cally taken from the hearing aid record. To change the details, you will 
need to edit the hearing aid record in the Office Manager.

•	 Any notes that you add to the Notes section in the Settings window will 
be included in the test printout.

7.5.3  Adjusting the ANSI 96 Test Settings
The main ANSI 96 test settings are available in the test window.

•	 Aid Type

-	 Adaptive AGC: For compression hearing aids that need a long time 
to adjust to the test signal before taking the measurement.

-	 AGC: For normal compression hearing aids.

-	 Linear 60: For most linear hearing aids

-	 Linear 50: For high gain linear hearing aids that may saturate at 60 
dB.

•	 Telecoil: Performs a telecoil measurement with the test sequence. The 
analyzer must support telecoil measurements.

•	 Battery: Performs a battery current measurement with the test sequence. 
The analyzer must support battery current measurements.

•	 Avg: The three frequency average used with the test sequence. This will 
almost always be the HFA 1000, 1600, 2500 frequencies.

Other settings are available in the Settings window that you open by clicking 

.

•	 Operator: The clinician who performs the test. You can use the drop 
down menu or type in the clinician’s name. Any new names typed into 
the test screen will be automatically added to the WinCHAP database.

•	 Aid Type: This setting is identical to the setting in the test window.

•	 Noise Reduction: This performs a set number of measurements at each 
frequency in the test and averages the measurements together to deter-
mine the final test result. Choices are OFF (one measurement per frequen-
cy), 2X, 4X, 8X, 16X.
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In the ANSI tab of the Settings window:

•	 OSPL90, RESP, and SPLITS colors: This allows you to change the colors 
used for the curves in the ANSI test.

•	 Telecoil: This setting is identical to the setting in the test window.

•	 Battery: This setting is identical to the setting in the test window.

•	 Avg: This setting is identical to the setting in the test window.

•	 Attack & Release and I/O frequencies: Enable the frequencies that you want 
to test. These tests will only be performed when the Aid Type is set to AGC 
or Adaptive AGC.

•	 12 dB Harm Dist Rule: Enable this selection to enable the rule. When 
enabled. harmonic distortion will NOT be measured when the 2nd harmon-
ic has an amplitude that is 12 dB greater than the amplitude at the primary 
frequency.

Notes:

•	 Use the Save Settings button in the Settings window to save all the current 
settings as defaults.

•	 Use the Restore Defaults button in the Settings window to restore all set-
tings to factory defaults.

•	 Use the Get Info button in the Settings window to automatically grab the 
analyzer type and serial number used to perform the test.

•	 The hearing aid information shown in the Settings window is automatically 
taken from the hearing aid record. To change the details, you will need to 
edit the hearing aid record in the Office Manager.

•	 Any notes that you add to the Notes section in the Settings window will be 
included in the test printout.

7.5.4  Adjusting the ANSI 03 Test Settings
The main ANSI 03 test settings are available in the test window.

•	 Aid Type

-	 Adaptive AGC: For compression hearing aids that need a long time to 
adjust to the test signal before taking the measurement.

-	 AGC: For normal compression hearing aids.

-	 Linear:  For linear hearing aids

•	 Telecoil: Performs a telecoil measurement with the test sequence. The ana-
lyzer must support telecoil measurements.

•	 Battery: Performs a battery current measurement with the test sequence. 
The analyzer must support battery current measurements.

•	 Avg: The three frequency average used with the test sequence. This will 
almost always be the HFA 1000, 1600, 2500 frequencies.
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Other settings are available in the Settings window that you open by clicking .

•	 Operator: The clinician who performs the test. You can use the drop down 
menu or type in the clinician’s name. Any new names typed into the test 
screen will be automatically added to the WinCHAP database.

•	 Aid Type: This setting is identical to the setting in the test window.

•	 Noise Reduction: This performs a set number of measurements at each fre-
quency in the test and averages the measurements together to determine the 
final test result. Choices are OFF (one measurement per frequency), 2X, 4X, 
8X, 16X.

 In the ANSI tab of the Settings window:

•	 OSPL90, RESP, and SPLITS colors: This allows you to change the colors used 
for the curves in the ANSI test.

•	 Telecoil: This setting is identical to the setting in the test window.

•	 Battery: This setting is identical to the setting in the test window.

•	 Avg: This setting is identical to the setting in the test window.

•	 Attack & Release and I/O frequencies: Enable the frequencies that you want 
to test. These tests will only be performed when the Aid Type is set to AGC or 
Adaptive AGC.

•	 12 dB Harm Dist Rule: Enable this selection to enable the rule. When 
enabled. harmonic distortion will NOT be measured when the 2nd harmonic 
has an amplitude that is 12 dB greater than the amplitude at the primary fre-
quency.

•	 AGC Switching: When enabled and the Aid Type is set to AGC, the analyzer 
will pause before the attack and release and I/O measurements in order to 
allow the user to set the compression of the hearing aid to maximum.

Notes:

•	 Use the Save Settings button in the Settings window to save all the current 
settings as defaults.

•	 Use the Restore Defaults button in the Settings window to restore all settings 
to factory defaults.

•	 Use the Get Info button in the Settings window to automatically grab the ana-
lyzer type and serial number used to perform the test.

•	 The hearing aid information shown in the Settings window is automatically 
taken from the hearing aid record. To change the details, you will need to edit 
the hearing aid record in the Office Manager.

•	 Any notes that you add to the Notes section in the Settings window will be 
included in the test printout.
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7.6  Other Automated Test Sequences (ANSI 92, JIS, IEC)
There are several automated test sequences available that are not associated with 
the ANSI S3.22 standard. They are:

•	 The ANSI 92 is an automated test sequence the uses a noise signal to give 
you a family of curves and is according to ANSI S3.42-1992.

•	 The IEC sequence is an automated test used by the international community.

•	 The JIS sequence is an automated test used primarily in Japan.

Figure 7.6—The IEC automated test sequence window

7.6.1 Getting a test sequence
The most straight forward way to save the automated test sequence results into the 
database is to use the Get Test button:

1.	 Set the analyzer up for normal coupler testing.

2.	 Run the automated test sequence on your analyzer as you normally would.

3.	 Click Get Test in the automated test sequence window in WinCHAP. The 
will cause WinCHAP to grab all test data currently displayed on your ana-
lyzer.

4.	 Click Save in the toolbar to save the results.
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7.6.2 Starting a test sequence
If your analyzer is already set up for testing, then you can remotely start the 
automated test sequence from WinCHAP by clicking Start Test:

1.	 Set the analyzer up for normal coupler testing.

2.	 Click Start Test in the automated test sequence in WinCHAP. This will 
remotely start the automated test sequence on your analyzer.

3.	 If the analyzer pauses midway through the test to allow for adjustment of 
the hearing aid to reference test gain (or to put the aid in telecoil mode), 
a window will pop up on WinCHAP, telling you what to do. Adjust the 
hearing aid accordingly.

4.	 Click OK in the test window when you have done the adjustment. 
WinCHAP will tell the analyzer to resume testing. When the test sequence 
is done, WinCHAP will display the results.

5.	 Click Save in the toolbar to save the results.

7.7 Coupler Directional
Coupler Directional is a new test designed specifically for the FONIX 8000 
Hearing Aid Test System. It measures polar plots of directional hearing aids as 
well as a front-back ratio called a “Difference Test.” 

You can use the Coupler Directional test screen in WinCHAP to grab test results 
that have been previously made on the FONIX 8000 Hearing Aid Test System. 
Test results can be copied and pasted to a program such as Excel or printed 
from the test screen.

7.7.1 Understanding the Coupler Directional Display
The Coupler Directional test displays the numerical test results from the polar 
plot and difference tests made on the FONIX 8000. 

The Polar Plot curve box shows you the numerical data of any polar plot mea-
surements made on the FONIX 8000. Tests results can be shown in either Gain 
or SPL. See Figure 7.7.1A.
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Figure 7.7.1A: Polar Plot measurement results

The text box shown in the upper right side of the Coupler Directional test dis-
plays the “ear” recorded for the test results as well as the basic curve parameters 
for each one of the test curves:

•	 Freq: The frequency used for the polar plot of each ear. If “Comp” is dis-
played, the polar plot shown is the overall RMS of the Composite curve 
instead of a particular frequency.

•	 dB: The input level used for the polar plot and difference curve test 
results.

•	 NR: The noise reduction used for the difference curve test results. Noise 
reduction is not used in the polar plot results.

•	 Filter: The filter used for each curve. Puretone curves always have a “flat” 
filter. Composite curves generally have the ANSI or ICRA filter.

•	 Fwd/Rev: These are the “forward” and “reverse” angles used in the 
Difference Test. The frequency response taken at the “reverse” angle is 
subtracted from the frequency response taken at the “forward” angle.

See Figure 7.7.1B.



Figure 7.7.1B: Curve text box for Coupler Dirctional

The curve parameter box shown in Figure 7.7.1C displays additional curve 
parameters for a particular curve. Select the curve parameters to display by 
clicking on the curve name in the curve box (shown in the previous section).

•	 Polar Plot Type: The number of angles tested for the polar plot.

•	 Mode: Whether the test results were made in Simultaneous Mode or 
Manual/Semi-Auto/Automatic mode.

•	 Polar Plot Signal: Whether the test signal was presented continuously or 
whether it was turned off while the analyzer was rotating between angles.

Figure 7.7.1C: Curve parameter box 

The Difference Curve box displays the test results for the difference curve. Test 
results are always “Gain” since this test is a subtraction between the forward 
and reverse frequency responses. See Figure 7.7.1D.

Figure 7.7.1D: Difference test data
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7.7.2 Using Coupler Directional
To grab Coupler Directional test results from your FONIX 8000 Hearing Aid Test 
System:

•	 Perform the desired testing on the FONIX 8000. See the FONIX 8000 
Operator’s Manual for details.

•	 Create a new hearing aid test, choosing Coupler Directional. See Section 
4.2.2.

•	 Click the Get Test button. This will grab all Coupler Directional test 
results shown on your FONIX 8000.
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WinCHAP NOAH® 3 Module
8.1  Introduction

The FONIX WinCHAP NOAH module is a program that runs inside NOAH 3 
and allows you to import and export data between NOAH and WinCHAP. More 
specifically, you can use it to:

•	 Export client information from NOAH 3 to WinCHAP

•	 Import and export the client’s audiogram to and from NOAH 3 and 
WinCHAP

This lets you grab a NOAH audiogram and insert it into WinCHAP. From 
WinCHAP, you can either create one of the linear targets and send it over to 
your FONIX hearing aid analyzer (see Section 5.5.1), or you can use the DSL/
NAL test to perform DSL or NAL-NL1 fittings (see Chapter 7).

All real-ear and coupler measurements are saved in WinCHAP and not in 
NOAH 3. If you want to work exclusively in NOAH 3 and not use the WinCHAP 
database, see our other program, the FONIX NOAH Module.A free demo of this 
product is available on our website: http://www.frye.com.

There is also a separate NOAH 3 import utility in WinCHAP that allows you to 
import the entire NOAH 3 database using the NOAH 3 XML data export func-
tion. This is described in Section 8.6.

8.2  Installation & Setup
This section describes how to install the WinCHAP NOAH Module inside 
NOAH and open it, once it has been installed.

8.2.1  Installing the WinCHAP NOAH Module
There are two ways to install the WinCHAP NOAH Module. The easiest way is 
to install it from WinCHAP. You can also install it from NOAH 3.

8.2.1.1  To install the NOAH Module from WinCHAP
This method is the easiest (and the preferred) way to install the NOAH 3 
Module.

1.	 Make sure you have properly installed WinCHAP. See Chapter 1. NOAH 3 
should also be installed.

2.	 Open WinCHAP.

3.	 Open the Tools menu and select NOAH 3 Tools. This will open the NOAH 
3 Tools window. See Figure 8.2.1.1.

4.	 Click Install NOAH 3 Module to install the WinCHAP NOAH Module. A 
window will pop up, confirming your success.
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Figure 8.2.1.1

8.2.1.2  To install the NOAH 3 Module from NOAH 3.
We recommend using the installation method specified in Section 8.3.1.1, but 
you can also use the following method.

1.	 Open NOAH 3.

2.	 Open the Tools menu and point at Setup.

3.	 Select Install Module. This will bring up the Module Installation window.

4.	 Click Install.

5.	 Open the NOAHModule directory in the WinCHAP directory. On most 
computers, this will be: C:\Program Files\Frye Electronics\WinCHAP\
NOAHModule

6.	 Select install.ini and click Open. This will install the WinCHAP NOAH 
module.

8.2.2  Opening the WinCHAP NOAH Module
1.	 Select a client in the Client Register window.

2.	 Click , the Open Module Selection button. 

3.	 Select the Measurement tab.

4.	 Select Frye Electronics. This will open the WinCHAP Module. See Figure 
8.3.

8.2.3  Selecting the WinCHAP database and executable
When installing the NOAH module, it should automatically figure out where 
the WinCHAP executable and database files are located. If for some reason this 
doesn’t work, you can set these locations manually.

1.	 Open the Frye Tools menu.

2.	 Point at Settings and select Set WinCHAP Database
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3.	 Using the file manager, select the location of the WinCHAP database. The 
default location is:  
C:\Program Files\Frye Electronics\WinCHAP\Winchap0.mdb.  
However, the location of your WinCHAP database file may be different. 
When in doubt, open WinCHAP and look at the bottom of the WinCHAP 
window; the pathname and the file name of the database file will be dis-
played.

You may have to repeat this process to set the WinCHAP executable file. 
This is usually in the location: C:\Program Files\Frye Electronics\WinCHAP\
WinCHAP32.exe.

8.3  NOAH Audiograms
The NOAH Audiogram Section contains a listing of all audiograms saved in 
NOAH 3 for the current client. See Figure 8.3.

In order to use an audiogram saved in NOAH 3 to create a target in WinCHAP 
and send that target to your FONIX analyzer, you must first export the NOAH 
audiogram to WinCHAP. 

To export NOAH audiogram to WinCHAP

1.	 If needed, click on the NOAH Audiogram tab to enter the NOAH 
Audiogram Section and display the window shown in Figure 8.3.

2.	 Select the desired NOAH session in the top box.

3.	 Select the desired audiogram in the bottom box. 

4.	 Click Export Audiogram to WinCHAP.

Note: If the current client information does not exist in WinCHAP, it will auto-
matically be exported to WinCHAP with the audiogram.

If you don’t see the NOAH session or audiogram you want to export, try click-
ing Refresh Session List. This will update the NOAH listing of sessions and 
audiograms.
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Figure 8.3—Viewing NOAH audiograms 

8.4  WinCHAP Audiograms
Once you have exported a NOAH audiogram to WinCHAP (or if you create an 
audiogram for that client inside WinCHAP), it will appear in the WinCHAP 
Audiogram Section. If you have any audiograms saved in WinCHAP but not 
saved in NOAH 3, you can import them.

To import an audiogram from WinCHAP

1.	 Click on the WinCHAP Audiogram tab to enter the WinCHAP Audiogram 
Section and display the window shown in Figure 8.4.

2.	 Select the desired WinCHAP audiogram.

3.	 Click Import Audiogram to NOAH.

If you don’t see the WinCHAP audiogram you want to import, click Refresh 
Audiogram List. This will update the WinCHAP listing of audiograms.

To open a WinCHAP Audiometric Window, you can either double-click on 
the desired audiogram, or click on it once and then click View Audiogram in 
WinCHAP. From this window, you will be able to create a target to send to the 
analyzer or just send the audiogram to the analyzer. See Sections 5.5.1 and 
5.5.2.
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Figure 8.4—Viewing WinCHAP audiograms

8.5  Miscellaneous Functions & Settings
•	 If you only want to export client information (and not an audiogram), 

click Export Client to WinCHAP. This will create a new client record in 
WinCHAP. Unfortunately, there is no way to import client information, 
except audiograms, from WinCHAP into NOAH 3.

•	 To open WinCHAP’s Test Menu to the current client, click Start WinCHAP.

8.6  Importing the entire NOAH 3 database
With software version 2.60, we have added the ability to import the entire 
NOAH 3 database using the XML database export feature in NOAH 3.

To create the XML file:

1.	 Open NOAH 3.

2.	 Open the File menu and select Client Export. This will open the NOAH 3 
export wizard.

3.	 Click Next.

4.	 Select the last option in the list of export selections. This will export all 
data in XML format.
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5.	 Click Next.

6.	 Select Export to a single file containing data for all clients.

7.	 Click Next.

8.	 Enter a file name for the exported XML data.

9.	 Click Finish. NOAH 3 will perform the export.

To import the XML into WinCHAP:

1.	 Open WinCHAP.

2.	 Open the Tools menu and select NOAH 3 Tools.

3.	 Select Import NOAH XML File. This will open the NOAH XML Import 
window. See Figure 8.6.

4.	 Click Select a NOAH XML File and find the XML file you created above.

5.	 Select the clients you want to import by highlighting the individual 
names. To import all clients, click the Select All button.

6.	 Click Import NOAH XML File. This will perform the import. If you 
encounter a client already entered into WinCHAP, you will be asked if 
you want to create a duplicate record.

Figure 8.6—NOAH XML Import window



WinCHAP User’s Manual The NOAH 3 Module   119

8.7  Incorporating the NOAH 3 Module into your practice
The following are some suggestions on how to use WinCHAP in your clinic. 

8.7.1  If you have a FONIX analyzer and non-FONIX audiometer
We recognize that many FONIX users have FONIX analyzer and non-FONIX 
audiometers. Here are some suggestions on how to incorporate WinCHAP into 
such a situation.

8.7.1.1 Create client information and audiogram in NOAH 3
1.	 Create new client file in NOAH 3.

2.	 Create the audiogram in NOAH 3, using your non-FONIX audiometer.

3.	 Open the WinCHAP module in NOAH 3. See Section 8.2.2.

4.	 Select client’s NOAH audiogram in NOAH Audiograms Section and 
export that audiogram to WinCHAP. See Section 8.3 for details.

8.7.1.2  Send Insertion Gain Target to FONIX analyzer
1.	 From the WinCHAP NOAH Module, select the WinCHAP Audiogram tab. 

This displays a list of all the audiograms saved in WinCHAP.

2.	 Select the audiogram from which you want to create a target. This will 
open the WinCHAP Audiogram Window with that audiogram displayed.

3.	 See Section 5.5.1 and 5.5.2 for instructions on how to send an audiogram 
to your analyzer and how to create an insertion gain target and send it to 
your analyzer.

8.7.1.3  Enter the hearing aid into the WinCHAP database
If you want to save measurement curves to WinCHAP, you must first enter the 
hearing aid being measured into the WinCHAP database and assign the aid to 
your client.

Use the instructions found in Section 3.2.2 or Section 3.3.2 to enter the hearing 
aid into the database using either the Quick Entry Hearing Aid window or the 
Office Manager, respectively.

8.7.1.4  Save the measurement curves
1.	 Open a hearing aid test window by either:

•	From the Test Menu, click on the hearing aid listed under the client’s 
name.

•	From the WinCHAP Audiogram Window, click Client & Test Info and 
double-click on the hearing aid.
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2.	 Select the type of test you want to perform.

3. 	 Perform the measurements on the analyzer as usual.

4. 	 Click Get Curves to get the measurement curves from the analyzer.

5. 	 Click Save.

8.7.2  If you have a FONIX analyzer and FONIX audiometer
If you have a FONIX analyzer and a FONIX audiometer, the fitting process is 
slightly different.

8.7.2.1  Create the client information in NOAH 3.
1.	 Create new client file in NOAH 3.

2.	 Open the WinCHAP module in NOAH 3. See Section 8.2.2.

3.	 Click Export Client to WinCHAP. 

4.	 Click Start WinCHAP. This will open the Test Menu in WinCHAP.

8.7.2.2  Create audiogram in WinCHAP
1.	 Click on the client’s name in the right column of the Test Menu.

2.	 Click Audiometric Test.

3.	 Create the client’s audiogram. See Chapter 5 for more details.

To enter the hearing aid into the WinCHAP database and save the measurement 
curves, see Sections 8.7.1.3 and 8.7.1.4. To export the WinCHAP audiogram into 
NOAH 3, follow the directions found in Section 8.4.
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Index
Symbols

1/3 Gain  56
12 dB Harm Dist Rule  105, 106
6500-CX multicurve  95, 100

A

about  10
account information  26
ACIC  45
Adaptive AGC  103, 104, 105
add aid button  21
add curves  96, 102
AGC  103, 104, 105
AGC Switching  106
Aided  51
Aid Type  103, 104, 105, 106
amplitude  80
analyzer  81, 101
analyzer label  93
analyzer tools  10
ANSI  45
ANSI 03  105
ANSI 87  103
ANSI 92  107
ANSI 96  104
ANSI S3.22  102
applied filtering  91
apply corrections  82
apply HL corrections  84
assessment graph  65
attach

client record  22, 28
hearing aid record  21, 25

Attack & Release  105, 106
audiogram  53, 57, 115
audiometer  48, 50, 81
Audiometer Control Panel  53
audiometric symbols  83
audiometric test  47

create  47
open  48

Audiometric Test window  45
audiometry table  66
automated test sequence  87, 102

available hearing aids box  25
Avg  103, 104, 105, 106

B

backup  6
Battery  103, 104, 105, 106
Berger  56
bias  92
bone conduction  66
Bone Conduction  51

C

center graph  90
change client  61
channels  78, 84
CHAP  15
charges  26
check analyzer  10
check button  48, 49, 88
CIC  92
circuit type  72, 84
Client-Patient window  41
client record

attach  28
delete  25
list  37
office manager  24
quick entry  20
search  36
sort  37
unattach  32

client services button  26
client’s hearing aids box  25
colors  54, 64, 90
COM port  48, 89
COM ports  11
compression threshold  72, 77, 82
connect button  50, 95, 99
connection  10, 48, 88
copy data  74, 79, 91
copy selection  74, 79, 91
Coupler Directional  108
create

audiometric test  47
client record  20, 24
client test  45
database  14
DSL/NAL test  59, 60
hearing aid model  27



122   Index WinCHAP User’s Manual	

hearing aid record  22, 28
hearing aid test  45, 57, 88, 108
manufacturer record  32
personnel record  35
target  101
test instruments record  34

criteria button  38
curve

adding  96, 102
colors  64, 90
deleting  98
labels  98
numbers  90
parameters  79, 91
sending  96, 101
symbols  82
values  91

curve colors  54
custom color  54
customizing settings  63
custom labels  98
custom mold  67

D

data  90, 92
database  114

delete  14
new  14
opening  14

Database Manager  13
Data Entry window  19
date/time  18
default labels  98
delete

client record  25
curves  98
database  14
DSL-NAL data  62
hearing aid record  31
individual hearing aid  31
manufacturer record  33
personnel record  35
test  45
test instruments record  34

delete button  54
distortion  91
DSL  59, 71
DSL/NAL Test  45

E

ear  92
editing records  44
environment  91
Excel  74, 79, 91
export

audiogram  115
client  117
data  74, 79, 91, 113

F

filter  85, 91
finding records  44
first button  36, 43
fitting type  78, 83
full-on gain  81

G

gain  78
get curves button  95, 100
Get Info  104, 105, 106
Get Test  107
graphical display  89
graphic settings  54
graph lines  82
grid  54

H

header  17
hearing aid model  27
hearing aid record

attach  21, 25
delete  31
individual aid  28
list  37
office manager  27
quick entry  21
search  36
sort  37
unattach  25

hearing aid repair log  29
hearing aid serial number  27
hearing aid simulator  52
hearing aid style  72, 82
hearing aid test  57
Hearing Aid window  41
HL to SPL Transform  72, 84
HTL  51, 64
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I

IEC  45, 87, 107
impedance  56
import

audiogram  116
data  113
database  16, 117

individual hearing aid  28, 31
info window  81
input  52
insert earphone  67
insertion gain  78, 100
insitu  91
installation  5, 113
I/O frequencies  105, 106

J

JIS  45, 87, 107

L

label  10, 93, 98
last button  36, 43
level  11
leveling  91, 93
limiting  83
Linear  105
Linear 50  103, 104
Linear 60  103, 104
line feed  11, 93
list  37
live speech  74
log  29
logo  17
loudness function  84
loud speaker orientation  65, 72, 77, 82
LTASS  73, 75

M

Main Menu  9
manufacturer record

create  32
delete  33
list  37
search  36
sort  37

maximum output  72, 84
model  27

N

NAL  45
NAL-NL1  59, 76
NAL-R  56
network  14
next button  36, 43
NOAH  9, 113
noise reduction  92
Noise Reduction  103, 104, 106
no response  52
Notes  104, 105, 106
numerical data  90

O

OES  91
Office Manager  23
open

audiometric test  48
DSL/NAL test  60
existing test  45
hearing aid test  88
NOAH module  114
response curves test  94

operator  48, 81
Operator  103, 104, 106
ordering records  44
OSPL90  103, 105, 106
output  52
output conditions  80
output limiting  77

P

parameters  79, 92
patient response button  51
payments  26
personnel record

create  35
delete  35
list  37
search  36
sort  37

picture  40
POGO  56
polar plot  108
previous button  36, 43
print  10, 11, 17, 49, 93

DSL-NAL test  61
print configuration  54
PT Signal Mode  76, 82
pure-tone testing  49, 76
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Q

Quick Entry
client  20
hearing aid  21

R

real-ear test  87, 99
Real Ear window  45
RECD  66, 84
records

editing  44
moving between  43
order  44

REDD  70
reference mic  91
reference position  77, 83
refresh button  54
registration  6
remote control  52
repairs  29
requirements  7
reset  11, 93
RESP  103, 105, 106
response curves  87, 94
Response Curves window  45
Restore Defaults  104, 105, 106
RE to 2cc Transform  72, 84
RMS  92
RS232  8

S

Save Settings  104, 105, 106
scaling  80
search aid button  25
search record  36
search records  44
send audiogram  57
send curves  96, 101
serial number  27
serial port  11
set audiometer button  53
set label  10
settings  62
setup  7
show HL to SPL transform  82
signal filter  85
signal type  91
smoothing  91
sort  37
sorting records  44

source type  91
spectrum analysis mode  74
speech audiometry  55
speech weighting  75
SPL  100
SPLITS  105, 106
spreadsheet  74, 79, 91
SSPL  78, 81
start test  108
symbols  54, 83

T

talk forward  49
target  56, 101
targets  75
Telecoil  103, 104, 105, 106
test frequency  80
test instruments record

create  34
delete  34
list  37
search  36
sort  37

Test Menu window  41
transaction  26
transducer  65, 72, 77, 82
tubing  78, 84

U

UCL  51, 64
UK symbols  54
Unaided  51
unattach

client record  32
hearing aid record  25

upper limit  66
USB  8
user gain  81
US symbols  54

V

venting  78, 84
verification  71

W

website  9

X

XML  117


